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About This Guide

IMPORTANT! Before using this product, read and understand the information the
“Safety” appendix in this document.

Revision history

Revision Date Description

A May 2012 New document. Combines information for
AmpF(STR® Profiler Plus® and Profiler Plus® /D
PCR Amplification Kits into one user guide.

Add validation experiments and results for buffer
and enzyme kit component changes.

B August 2012 Update language in validation experiments and
results for buffer and enzyme kit component
changes.

Purpose

The Applied Biosystems AmpF(STR® Profiler Plus® and Profiler Plus® ID PCR
Amplification Kits User Guide provides information about the Applied Biosystems
instruments, chemistries, and software associated with the AmpFlSTR® Profiler Plus®
and Profiler Plus® ID PCR Amplification Kits.

User attention words

Five user attention words may appear in this document. Each word implies a
particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation
or accurate chemistry kit use.

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide 9



About This Guide
User attention words

CAUTION! Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe
practices.

WARNING! Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

10 AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide
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Product overview

Purpose

Product
description

About the primers

The AmpF(STR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits are short
tandem repeat (STR) multiplex assays that amplify 9 tetranucleotide repeat loci
(D351358, vWA, FGA, D8S1179, D21S11, D18551, D5S818, D13S317, D75820) and the
Amelogenin gender-determining marker in a single PCR amplification. Both kits use
the same reaction conditions and thermal cycling parameters.

The Profiler Plus® and Profiler Plus® ID Kits contain all the necessary reagents for the
amplification of human genomic DNA.
The reagents are designed for use with the following Applied Biosystems instruments:
e Applied Biosystems 3100/3100-Avant Genetic Analyzer
¢ Applied Biosystems 3130/3130x/ Genetic Analyzer
¢ Applied Biosystems 3500/3500xL Genetic Analyzer
¢ Applied Biosystems 310 Genetic Analyzer
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
o Veriti® 96-Well Thermal Cycler

The Profiler Plus® and Profiler Plus® ID Kits employ the same primer sequences for all
loci common to other AmpF(STR® kits (except the MiniFiler™ kit).

The Profiler Plus® ID Kit includes the degenerate unlabeled primer for the D8S1179
locus that was also included in later AmpF(STR® kits. This primer was added to
address a mutation observed in a population of Chamorros and Filipinos from Guam
(Budowle et.al., 2000). A single G-to-A transition (point mutation) was observed in all
null alleles at the D851179 reverse primer-binding site.

This primer amplifies D851179 alleles in samples containing this mutation and does
not alter the overall performance of the kit (Figure 1).

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide 11
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Product overview

Figure 1 Profile of a DNA sample (heterozygous with one mutant allele) amplified without (A)
and with (B) the D8S1179 unlabeled primer along with the standard primers
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The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The Allelic Ladder in each kit is used to
genotype the analyzed samples from both the Profiler Plus® and Profiler Plus® ID Kits.
The alleles contained in the allelic ladders and the genotype of the AmpF/STR®
Control DNA 9947A are also listed in the table.

Table 1 Profiler Plus® Kit and Profiler Plus® /D Kit loci and alleles (both kits use the same
allelic ladder configuration)

Chromosome Alleles included in AmpF¢{STR® Profiler Dve Control DNA
Locus designation location Plus® Allelic Ladder and AmpF{STR® lazel 9947A
Profiler Plus® ID Allelic Ladder

D35S1358 3p 12,13, 14, 15, 16, 17, 5-FAM™ 14,15
18, 19

vWA 12p12-pter 11,12, 13, 14, 15, 16, 17, 18
17, 18, 19, 20, 21

FGA 4928 18, 19, 20, 21, 22, 23, 23, 24
24, 25, 26, 26.2, 27,
28, 29, 30

Amelogenin X: p22.1-22.3 XY JOE™ X

Y:p11.2

D851179 8 8,9, 10, 11,12, 13, 13t
14,15, 16, 17, 18, 19

D21S11 21 24.2, 25, 26, 27, 28, 30%
28.2,29,29.2,30,30.2,31,31.2,32,32.2, 33,
33.2, 34, 34.2, 35, 35.2, 36, 38

D18S51 18qg21.3 9,10, 10.2, 11,12, 13, 13.2, 14, 14.2, 15, 16, 15, 19
17,18, 19, 20, 21, 22,
23, 24, 25, 26

D55818 5921-31 7,8,9,10, 11, 12, 13, NED™ 118
14,15, 16

D13S317 13q22-31 8,9, 10, 11, 12, 13, 14, 15 111t

D75820 7911.21-22 6,7,8,9 10, 11,12, 10, 11
13, 14, 15

1t For CODIS purposes, profile reported as 13, 13.
I For CODIS purposes, profile reported as 30, 30.
§ For CODIS purposes, profile reported as 11, 11.
Tt For CODIS purposes, profile reported as 11, 11.

12 AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide
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Product overview

Allelic ladder Figure 2 shows the allelic ladder profile for the Profiler Plus® and Profiler Plus® ID

profile Kits. See “Allelic ladder requirements” on page 25 for information on ensuring
accurate genotyping.

Figure 2 GeneMapper® ID-X Software plot of the AmpF(STR® Profiler Plus® Allelic Ladder and the AmpF(STR® Profiler
Plus® ID Allelic Ladder
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Product overview

Control DNA 9947A  Figure 3 shows amplification of Control DNA 9947A using the Profiler Plus® Kit.
profile

Figure 3 1 ng of Control DNA 9947A amplified with the Profiler Plus® Kit and analyzed on the Applied Biosystems 3130x!
Genetic Analyzer
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Workflow overview

Chapter 1 Overview
Workflow overview
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Instrument and software overview

Instrument and software overview

Data Collection and

GeneMapper® ID
or ID-X Software

Instrument and
software
compatibility

About
multicomponent
analysis

16

This section provides information about the Data Collection Software versions
required to run the Profiler Plus® and Profiler Plus® ID Kits on specific instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software stores
information about each sample in a sample file (.fsa), which is then analyzed by the
GeneMapper® ID or ID-X Software.

Table 2 Software specific to each instrument

Instrument Operating Data Collection Analysis software
system Software
3500/3500xL e Windows® XP 3500 Series GeneMapper® /D-X Software
o Windows Data Collection | v1.2 or higher
Vista® Software v1.0
3130/3130x! Windows® XP 3.0 » GeneMapper® ID
- Software v3.2.1
3100/3100-Avant | Windows® NT 1.1 (3100)

1.0 (3100-Avant)

and

* GeneMapper® ID-X
Software v1.0.1 or higher

Windows® 2000 2.0
310 Windows® XP 3.1
e Windows® NT | 3.0
e Windows®
2000

Note: We conducted validation studies for the Profiler Plus® and Profiler Plus® ID
Kits using the Applied Biosystems 310 Genetic Analyzer running Mac OS®. This
configuration is now obsolete.

Applied Biosystems fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the four different fluorescent
dye colors into distinct spectral components. The three dyes used in the Profiler Plus®
and Profiler Plus® ID Kits to label samples are 5-FAM™, JOE™, and NED™ dyes. The
fourth dye, ROX", is used to label the GeneScan"" 500 ROX" Size Standard.

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide



Chapter 1 Overview 1
Instrument and software overview

How Each of these fluorescent dyes emits its maximum fluorescence at a different
multicomponent wavelength. During data collection on the Applied Biosystems and Applied
Biosystems instruments, the fluorescence signals are separated by diffraction grating
according to their wavelengths and projected onto a charge-coupled device (CCD)
camera in a predictably spaced pattern. The 5-FAM"" dye emits at the shortest
wavelength and it is displayed as blue, followed by the JOE™ dye (green), NED
(yellow), and ROX™ dye (red).

analysis works

™

dye

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 4).
The goal of multicomponent analysis is to correct for spectral overlap.

Figure 4 Emission spectra of the four dyes used in the Profiler Plus® and Profiler Plus® /D Kits
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Materials and equipment

Materials and equipment

Kit contents and
storage

The Profiler Plus® Kit (Part no. 4303326) and the Profiler Plus® ID Kit
(Part no. 4330284) contain materials sufficient to perform 100 amplifications at

50 uL/amplification.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Component

Description

Volume

Storage

AmpFlSTR® PCR
Reaction Mix

Contains MgCl,, deoxynucleotide
triphosphates, and bovine serum albumin in
buffer with 0.05% sodium azide.

2 tubes, 1.1 mL
each

AmpF(STR® Profiler
Plus® or AmpF(STR®
Profiler Plus ®/D Primer
Set

Contains fluorescently labeled primers and
non-labeled primers.

1 tube, 1.1 mL

AmpF(STR® Profiler
Plus® Allelic Ladder or
AmpF(STR® Profiler
Plus® /D Allelic Ladder

Contains amplified alleles.

See Table 1 on page 12 for a list of alleles
included in the allelic ladders.

1 tube, 0.05 mL

-15 to -25°C on receipt,
2 to 8°C after initial use

AmpF(STR® Control Contains 0.10 ng/uL human female 9947A 1 tube, 0.3 mL
DNA 9947A DNA in 0.05% sodium azide and bufferT.
See Table 1 on page 12 for profile.
AmpliTag Gold® DNA Contains enzyme, with an activity of 5 U/uL. | 2 tubes, -15 to -25°C

Polymerase

0.05 mL/tube

t+ The AmpF(STR® Control DNA 9947A is included at a concentration appropriate to its intended use as an amplification control (i.e., to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF(STR® Control DNA 9947A is not designed
to be used as a DNA quantitation control, and you may see variation from the labelled concentration when quantitating aliquots of the
AmpF(STR® Control DNA 9947A.

Standards for
samples

18

For the Profiler Plus® and Profiler Plus® ID Kits, the panel of standards needed for

PCR amplification, PCR product sizing, and genotyping are:

e AmpF/STR® Control DNA 9947A - A positive control for evaluating the
efficiency of the amplification step and STR genotyping using the allelic ladder in

the kit.

e GeneScan"" 500 ROX™ Size Standard — Used for obtaining sizing results. This
standard, which has been evaluated as an internal size standard, yields precise
sizing results for PCR products generated by the kit. Order the GeneScan"" 500
ROX™ Size Standard (Part no. 4322682) separately.

e AmpF(STR® Profiler Plus® Allelic Ladder or AmpF{STR® Profiler Plus®ID
Allelic Ladder — Allelic ladders developed by Life Technologies for accurate
characterization of the alleles amplified by the Profiler Plus® and Profiler
Plus® ID Kits. The allelic ladders contain most of the alleles reported for the
9 autosomal loci. Refer to Table 1 on page 12 for a list of the alleles included in the

allelic ladders.
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Required user-supplied reagents

2.
3.

In addition to the Profiler Plus® and Profiler Plus® ID Kits reagents, the use of low-TE
buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can prepare the
buffer as described in the procedure below or order it from Teknova (Cat # T0223).

To prepare low-TE buffer:
1.

Mix together:
e 10mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
Aliquot and autoclave the solutions.

Store at room temperature.

DNA quantification

Importance of
quantification

Quantifying the amount of DNA in a sample before amplification allows you to
determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount of
DNA for the Profiler Plus® and Profiler Plus® ID Kits is 1.0-2.5 ng in a maximum input
volume of 20 uL for 28 PCR cycles.

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide 19



Chapter 2 Perform PCR
DNA quantification

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the

instrument (“off-scale” data). Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur resulting in a partial profile.

Methods of
quantifying DNA

Life Technologies provides several kits for quantifying DNA in samples. See the
reference cited in the following table for details about these kits.

Product

Description

Quantifiler® Human DNA
Quantification Kit
(Part no. 4343895)

and

Quantifiler® Y Human Male
DNA Quantification Kit
(Part no. 4343906)

For more information, see
Quantifiler® Human DNA
Quantification Kits User’s Manual
(Pub. no. 4344790)

Quantifiler® Duo DNA
Quantification Kit
(Part no. 4387746)

For more information, see
Quantifiler® Duo DNA
Quantification Kit User's Manual
(Pub. n0.4391294)

Properties:

The Quantifiler® Human and Quantifiler® Y Human Male Kits are highly specific for
human DNA, and they individually detect total human or male DNA, respectively. The
kits detect single-stranded and degraded DNA.

How they work:

The Quantifiler® DNA Quantification Kits consist of target-specific and internal control
5" nuclease assays.

The Quantifiler® Human and Quantifiler® Y Human Male Kits contain different target-
specific assays [human DNA or human male DNA, respectively] that each consist of two
locus-specific PCR primers and one TagMan® MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each contain a separate internal PCR control
(IPC) assay, which consists of an IPC template DNA (a synthetic sequence not found in
nature), two primers for amplifying the IPC template, and one TagMan® MGB probe
labeled with VIC® dye for detecting the amplified IPC.

Properties:

The Quantifiler® Duo Kit is highly specific for human DNA. This kit combines the
detection of both total human and male DNA in one PCR reaction.The kit detects single-
stranded and degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit consists of target-specific and internal
control 5' nuclease assays.

The Quantifiler® Duo kit combines two human-specific assays in one PCR reaction (for
total human DNA and human male DNAJ. The two human DNA specific assays each
consist of two PCR primers and a TagMan® probe. The TagMan® probes for the human
DNA and human male DNA assays are labeled with VIC® and FAM™ dyes, respectively.
In addition, the kit contains an internal PCR control (IPC) assay similar in principle to
that used in the other Quantifiler kits, but labeled with NED™ dye.
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction
AmpF(STR® PCR Reaction Mix 21.0 yL
AmpF(STR® Profiler Plus® or AmpF(STR® Profiler 11.0 uL
Plus ®ID Primer Set
AmpliTaq Gold® DNA Polymerase 1.0 L

Note: The volumes above include a slight overfill to provide excess volume for
the loss that occurs during reagent transfers.

2. Prepare reagents. Thaw the PCR Reaction Mix and the Primer Set, then vortex all
reagent tubes including the enzyme for 3 seconds and centrifuge briefly before
opening the tubes.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2 to 8°C and, therefore, they do not require subsequent
thawing. Do not refreeze these reagents.

3. Pipette the required volumes of components into an appropriately sized
polypropylene tube to create a master mix.

4. Vortex the master mix for 3 seconds, then centrifuge briefly.

5. Dispense 30 uL of the reaction mix into each reaction well of a MicroAmp®
Optical 96-Well Reaction Plate or each MicroAmp® tube.

6. Prepare the DNA samples:

DNA sample To prepare...
Negative control | Add 20 pL of low-TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).
Test sample Dilute a portion of the test DNA sample with low-TE buffer so

that 1.0-2.5 ng of total DNA is in a final volume of 20 uL. Add
20 pL of the diluted sample to the reaction mix.

Positive control Add 20 pL of 9947A control DNA (0.1 ng/pL).

The final reaction volume (sample or control plus master mix) is 50 pL.

7. Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical
Adhesive Film, or cap the tubes.

8. Centrifuge the tubes or plate at 3000 rpm for ~20 seconds in a tabletop centrifuge
(with plate holders if using 96-well plates).

9. Amplify the samples in a GeneAmp® PCR System 9700 with the silver or gold-
plated silver 96-well block or a Veriti® 96-Well Thermal Cycler.

Note: The Profiler Plus® and Profiler Plus® ID Kits are not validated for use with
the GeneAmp PCR System 9700 with the aluminium 96-well block. Use of this
thermal cycling platform may adversely affect performance of the kits.
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Select the correct PCR cycle number

Select the correct PCR cycle number

Perform PCR

22

All AmpF(STR® kits are optimized for a specific number of amplification cycles to
deliver well-balanced and high quality results. However, increases in the number of
low-level DNA samples being submitted for analysis have prompted many
laboratories to evaluate increasing the number of amplification cycles to increase the
sensitivity of the assay. Before increasing the cycle number, perform a comprehensive
validation study to establish new performance criteria for the higher cycle number.

Higher cycle numbers can cause the following to occur:
* Exaggerated stochastic effects resulting from low DNA input amounts
* Greater difference between the presence and absence of an allele
* Greater heterozygote peak imbalance
* Possible differences in expected stutter position and percentage
* DPossible increase in artifacts and/or background in the profile to accompany the

increase in sample allele signal

The Profiler Plus® and Profiler Plus® ID Kits are optimized for 28 cycles of
amplification only.

The results of developmental validation studies are shown in “Developmental
Validation of the Profiler Plus® Kit” on page 66.

1. Program the thermal cycling conditions:

* When using the GeneAmp PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

* When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal Cycler
AmpF(STR® Kit Validation (Pub. no.4440754).

Initial Melt Anneal Extend Final Final
incubation step extension hold
HOLD CYCLE (28) HOLD HOLD
95°C 94°C 59°C 72°C 60°C 25°C
11 min 1 min 1 min 1 min 45 min )

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® compression pad (Part no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not
require a compression pad.

3. Start the run.
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Amplification using bloodstained FTA® cards

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2 to 8°C
> 2 weeks -15to -25°C

IMPORTANT! Store the amplified products so that they are protected from light.

Amplification using bloodstained FTA® cards

FTA® cards can be useful for collecting, storing, and processing biological samples. A
small punch disc of the card containing the sample can be placed directly into an
amplification tube, purified, and amplified, without transferring the disc. Our studies
indicate that a 1.2-mm bloodstained disc contains approximately 5-20 ng DNA. An
appropriate cycle number for this high quantity of DNA is 25 cycles as determined by
our validation studies. However, it is recommended that each laboratory determine
the optimum cycle number based on internal validation studies.

In the example shown in Figure 5, a 1.2-mm disc of a bloodstained FTA card was
purified using three washes with FTA Purification Reagent and two washes with

1X low-TE buffer. The purified punch disc was then amplified in a MicroAmp® tube
for 25 cycles.

Figure5 Profiler Plus® Kit results from a 1.2-mm FTA bloodstain disc (25-cycle amplification)
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Amplification using bloodstained FTA® cards
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Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of allelic . _Ong Number of samples per
Instrument injection .
ladders to run equals allelic ladder(s)

3100-Avant or 3130 | 1 per 4 injections 4 samples 15 samples + 1 allelic ladder

3100 or 3130x( 1 per injection 16 samples | 15 samples + 1 allelic ladder
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples | 23 samples + 1 allelic ladder
310 1 per 10 injections | 1sample 9 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.
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3 Chapter 3 Electrophoresis
Allelic ladder requirements

It is critical to genotype using an allelic ladder run under the same conditions as the
samples because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Section 3.1 3100/3100-Avant and 3130/3130xl instruments
Set up the 3100/3100-Avant or 3130/3130x! instrument for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!
instruments

Set up the 3100/3100-Avant or 3130/3130x! instrument for
electrophoresis

Reagents and parts

Electrophoresis
software setup and

“Ordering Information” on page 113 lists the required materials not supplied with the
Profiler Plus® and Profiler Plus® ID Kits.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

The following table lists Data Collection Software and the run modules that can be
used to analyze Profiler Plus® and Profiler Plus® ID Kits PCR products. For details on

reference the procedures, refer to the documents listed in the table.
documents
Genetic Data Operatin
Collection P Run modules and conditions References
Analyzer g System
Software
Applied 3.0 Windows® ¢ HIDFragmentAnalysis36_POP4_1 Applied Biosystems 3130/3130x!
Biosystems XP Injection conditions: Genetic Analyzers Using Data Collection
3130/3130x! 3130 = 3 kV/5 sec Software v3.0, Protocols for Processing
AmpF(STR® PCR Amplification Kit PCR
- 3130x( = 3 kV/10 sec Products User Bulletin
e Dye Set F (Pub. no. 4363787)
Applied 2.0 Windows® e HIDFragmentAnalysis36_POP4_1 3100/3100-Avant Genetic Analyzers
Biosystems 2000 Injection condition: 3kV/10 sec Using Data Collection Software v2.0,
3100 e Dve Set F Protocols for Processing AmpF(STR®
y PCR Amplification Kit PCR Products
User Bulletin (Pub. no. 4350218)
1.1 Windows® ¢ GeneScan36_POP4DyeSetF 3100/3100-Avant Genetic Analyzers
NT Injection condition: 3kV/10 sec Protocols for Processing AmpF(STR®
e GS500Analvsis.as PCR Amplification Kit PCR Products
yots-gsp User Bulletin [Pub. no. 4332345)
Applied 1.0 Windows® e GeneScan36A_POP4DyeSetFModule = 3700/3100-Avant Genetic Analyzers
Biosystems NT Injection condition: 3 kV/5sec Protocols for Processing AmpF(STR®
3100-Avant e GS500Analysis.as PCR Amplification Kit PCR Products
yels-9sp User Bulletin [Pub. no. 4332345)
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3 Chapter 3 Electrophoresis
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instrument

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di'"" Formamide and size standard needed to prepare
the samples:

Reagent Volume: per
reaction
GeneScan™ 500 ROX™ Size Standard 05 pL
Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Pipette the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.
4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

* 9 uL of the formamide:size standard mixture
¢ 1 pL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

5. Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.
Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

e © ®©® =2 o

Start the electrophoresis run.
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Set up the 3500/3500xL iSsh:Srtni:? foEl:lCetcrt(;E;hoorrizz
Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 113 lists the required materials not supplied with the
Profiler Plus® and Profiler Plus® ID Kits.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Profiler Plus® and Profiler Plus® ID Kits PCR products. For details on
the procedures, refer to the documents listed in the table.
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reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3500 Data =~ Windows® e HID36_POP4 Applied Biosystems 3500/3500xL
Biosystems Collection XP Injection conditions: 1.2kV/15 sec Genetic Analyzer User Guide
3500 Software (Pub. no. 4401661)
1.0 or e Dye Set F
Applied Windows « HID36_POP4 Appl/ed Biosystems 3500 and 3500xL
Biosystems Vista® Injection conditions: 1.2kV/24 sec Genetic Analyzers Quick Reference
! o Card (Pub. no. 4401662)
3500xL
e Dye Set F

Prepare samples for electrophoresis on the 3500/3500xL
instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 500 ROX™ Size Standard 05 pL
Hi-Di™ Formamide 8.5 L

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
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Chapter 3 Electrophoresis

Prepare samples for electrophoresis on the 3500/3500xL instrument

e © ®©® =2 o

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each
MicroAmp® optical strip tube, add:

* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to
ensure that the contents of each well are collected at the bottom.

Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Set up the 310 instrument for electrophoresis

Section 3.3 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 113 lists the required materials not supplied with the
Profiler Plus® and Profiler Plus® ID Kits.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Profiler Plus® and Profiler Plus® ID Kits PCR products. For details on
the procedures, refer to the documents listed in the table.

reference
documents
Data Operatin Run modules and
Collection P 9 L References
System conditions
Software
317 Windows® XP e GS STR POP4 (1mL) 310 Genetic Analyzer User’'s Manual (Windows)
or or Injection condition: (Pub. no. 4317588
3.0t Windows® NT 15 kV/5 sec 310 Protocols for Processing AmpF(STR® PCR Amplification
and Windows® Kit Products with Microsoft Windows NT Operating System:
2000 User Bulletin (Pub. no. 4341742)

+ We conducted concordance studies for the Profiler Plus® and Profiler Plus® /D Kits using this configuration.

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 500 ROX™ Size Standard 0.75 pL
Hi-Di"™ Formamide 24.5 ul

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
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Prepare samples for electrophoresis on the 310 instrument

2. Pipette the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.
4. Into each 0.2 mL or 0.5 mL sample tube, add:

e 25 uL of the formamide:size standard mixture
¢ 1.5 pL of PCR product or allelic ladder
Note: For blank wells, add 25 uL of Hi-Di"" Formamide.

5. Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95°C.
Immediately place the tubes on ice for 3 minutes.
Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

© ® ® N o

Start the electrophoresis run.
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Section 4.1 GeneMapper® ID Software

Overview of GeneMapper® ID Software

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa file. Using GeneMapper® ID Software v3.2.1 software, you can then analyze
and interpret the data from the .fsa files.

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
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Set up GeneMapper® ID Software for data analysis

Before you start When using GeneMapper® ID Software v3.2.1 to perform human identification (HID)
analysis with AmpF(STR® kits, be aware that:

e HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

¢ Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

e Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.

Set up GeneMapper® /D Software for data analysis

File names The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®

ID Software.
Use the same analysis files for analysis of data from Profiler Plus® and Profiler
Plus® ID Kits.
Before using the Before you can analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for
software for the the first time, you need to:
first time ¢ Import panels and bins into the Panel Manager, as explained in “Import panels

and bins” on page 35.

¢ Create an analysis method, as explained in, “Create an analysis method” on page
38.

¢ Create a size standard, as explained in “Create size standard” on page 43.

* Define custom views of analysis tables.
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Section 4.1 GeneMapper® ID Software 4
Set up GeneMapper® ID Software for data analysis

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.
¢ Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.

Impo rt panels and To import the Profiler Plus® Kit panel and bin set into the GeneMapper® ID Software
bins v3.2.1 database:

1. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! If you need logon instructions, refer to page 2-7 of the GeneMapper®
ID Software Version 3.1 Human ldentification Analysis User Guide (Pub. no. 4338775).
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2. Select Tools » Panel Manager.

3. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

] Panel Manager

File Edit Bins View

=) N R M E EiinSet:l:
—

=1 Panel Manaoer

b. Select File » Import Panels to open the Import Panels dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder, where x is the drive on which the GeneMapper® ID Software is
installed.
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Set up GeneMapper® ID Software for data analysis

4. Select AmpFLSTR_Panels_v2.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, AmpFLSTR_Panels_v2. This folder contains the panels and associated
markers.

(7] Import Panels
Laoak in: |[ﬁ Panelz V| I ’”*'E

B [Z] AmpFLESTR Bins_w1 txt
4 [Z] AmpFLETR Bins_vw2 txd

Wiy Recent [Z] ampFLSTR_Panels_vw1 txt

BElELi B AmpFLSTR Parie
?I_-:
Deskiop
____/' File narme:; | AmpFLSTR_Panels_v2 txt C[imp
My Documents [ iles of type: |.ﬂ-.ll Files v | Can

5. Import AmpFLSTR_Bins_v2.txt:
a. Select the AmpFLSTR_Panels_v2 folder in the navigation pane.

(# ] Panel Manager
File Edit Bins View

X EEE BN o

= EJPanel Manager ~
= o ampFLSTR_Panels_v2 1
b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder.

d. Select AmpFLSTR_Bins_v2.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2 folder.

(7] Import Bin Set
Lok ir: |[ﬁ Panels V| I ,3|| =

[Z] AmpFLESTR Bins_w1 txt
L\b’ B AmpFLSTR Bins w2t

Wiy Recent ] ampFLSTR_Panels_vw1 txt
Documents [Z] ampFLSTR_Panels_v2 txt

?i__

Desktop

‘_j File: naime: |AmpFLSTR_EIinS_\.f2.t:d |
My Docurnerts | Files of type: |.ﬂ-.|| Files "| Cancel I
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Set up GeneMapper® ID Software for data analysis

6. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2 folder.

b. Double-click the Profiler_Plus_v2 folder to display the panel information in
the right pane and the markers below it.

File Edit Bins Wiew
BE X B M M M st |AmpFLSTR Bins_v2 ~| WM |.|.|= ] .|.‘ [®)
= EIPanel Manager A Dogkr Mame  |Dye Color | Bin Sime |Mix Sise |Conrol Alleles | Dker | Minker | Commeses | Ladder Alleles g
B S AmpFLSTR_Panels_v2 1 |pasiasa blue 950 [1480  [1415 011 none 121314151617 18,19 o)
[Jee vz 2 i bue (1510|2030 1718 4 041 |none 11,12,1314,15,1817,18,18,20.21 <
[Aereen__v2 QO
: 3 FGa bue (20625 |3800 (23,24 4 041 |nane 18,19,2021,22,23, 24,25 26 262,27 28, 29,30
[protiler w2 ©
2 [Epratier Pus vz 4 |aMEL een 1060|1140 |x F nn |none o i)
D3E1358 5 [DEs1Ta ween 1180|1835 13 4 042 |none 331011121314 151617 1819 o
WA, FREER een 1845|2475 |30 4 043 |none 242,25,26,27,29,28.2,29.29. 2 30,302,313 232,32 2,93 332,39 34 2 35,35 2 36 3 \®
;i’;l_ 7 |oiasst oreen  |26443 |3500 1518 4 016 |none 31010211 12,1313 21414 215 1617 18,1920 21 22,23 24 2526 w)]
DEs117a 5 |DSzals velow (1250 [1800 |11 4 04 |none 72310,11,1213,14,1518 wn
DS PR yelow 1920|2420 |11 4 01 |none 8310,111213,1415 o,
=
C18s5 — ! [10 |p7s820 yellow (2510|2885 |10, 4 003 |none 6759101112131415 =
DSSATE
0135317 2
D7EE20 @
[CHecotier_vz a
LB e T PR ST —
< I =

7. View the markers and display the Bin view in the navigation pane:

a. Double-click the AmpFLSTR_Panels_v2 folder to display its list of kits in
the right pane.

b. Double-click the Profiler_Plus_v2 folder to display its list of markers below
it.

c. Select D85S1179 to display the Bin view for the marker in the right pane.

Panel Manager

File Edit Bins Wiew

X 2 mm B Bk set: |ampFLSTR Bins_v2

= =IPanel Manager ~
= ESAMRFLSTR Pands v2 7 2 9 10 11 12 12 14 15 16 17 12 19 20
Blue_vz2 10
Careen__vz
L rrofiler_v2
= ESProfier_Plus_v2 o8
D351358
WA,
Foa 02
: o7
021511
018351 =
DosElg 0.8
D135317
DYsE20
A cotier_v2 05
P P L
< |
= 0.4
=lReference Samples
03
02
o1
0o
113 17 12 125 1249 133 137 141 145 148 153 157 161 165 1689 173 177 181 185
Das1178
& >
M 1156.88 v 0.61

[ Ok ][ Cancel H Apply ]
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8.

Click Apply, then OK to add the Profiler_Plus_v2 panel and bin set to the
GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels and
bins are not imported into the GeneMapper® ID Software database.

Create an analysis = The HID Advanced analysis method for the Profiler Plus® and Profiler Plus® ID Kits

method

uses the AmpFLSTR_Bins_v?2 file described in step 5 on page 36.

Use the following procedure to create a HID analysis method for the Profiler Plus®
and Profiler Plus® ID Kits.

1.

38

Select Tools » GeneMapper Manager to open the GeneMapper Manager.

(7] GeneMapper Manager

| Table Settings || Plat Settings || Matrices || Size Standards

Last Saved Owvrer Instrument Analysizs 1
IelertifilerDirect_HID_w1 2010-05-05 10:24:1 |grnicd HIC:
Idertifiler _Phis_Analysizbdet | 2011-05-13 14:41:1 | genid HID
Microsatelite Default 2010-01-27 14:58:0 | grnid Microsatel
£

Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

Select HID and click OK to open the Analysis Method Editor with the General
Tab selected.

The figures below show the settings for each tab of the Analysis Method Editor.
Configure settings as shown unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings (see step 5
on page 38). To complete this step quickly, do not save the analysis method until
you finish entering settings in all of the tabs.

Click Save.
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General tab =
. Analysis Method Editor - HID
settings £ =)
| General | allete || Peak Detector | Peak Qualty | cusity Flags |
~&nalysis Method Description

MNatne; | ProfilerPlus_Analysishethod_w1 |

Description: ~
- &
b’ >
(0]
<
)
Instrument: ie]
°
@
. )
Analysis Type: HID a
O
n
o
p=1]
£
)
=
(0]

[ QK ] [ Cancel ]

In the Name field, either type the name as shown, or enter a name of your choosing.
The Description and Instrument fields are optional.
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Allele tab settings

40

Analysis Method Editor - HID

x]

General | Peak Detector || Peak GQuality | Guality Flags
Bin et |.£\.mpFLSTR_Eiins_v2 v |
Use marker-specific stutter ratio it available
Marker Repesat Type Ti Tetra Perita Hexa
Cut-off Walue oa 0.0 oo oo
Witz Ratio 0.0 [In] [In] [In]
Mirus & Distance From |00 oo [uli} pi]
To 0.0 [In] [In] [In]
Minus Stutter Ratio oa 0.0 oo on
Witz Stutter Distance Frorm oo 325 0.0 0.0
Ta oa 475 oo oo
Pluz Stutter Ratio 0.0 [In] [In] [In]
Pluz Stutter Distance From |00 oo [uli} pi]
To 0.0 [In] [In] [In]
Arnelogenin Cutoff

Range Filter ...

[ Factory Defaults ]

[ [ cmen |

In the Bin Set field, select the AmpFLSTR_Bins_v2 bin set imported previously

and configure the stutter distance parameters as shown.

GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to

determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Panels_v2.txt file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the

appropriate filter setting to use.
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Peak Detector tab =
. Analysis Method Editor - HID
settings J tad
General | Allsle | Pesk Detector | peak Quality | Quality Flags
Peak Detection Algarithm: |Advanced hd |
Ranges Peak Detection
O Sizing Peak Ampliude Threshalds: .Perforr?
Full Range  w |.£\.II Sizes w B: | | R: | | Lnatﬁgl’;?lon
) (@)
G: | | 0 | | studies to @
: (0]
0 cetemne [
—=moathing and Baselining 9 ©
. Min. Peak Half wWidth: 2 pts 2
Srnocthing ) Mone ) 3 R
@ L Palynormial Degree: 5
() Heavy Peak Windave Size: 15 pts 7S
o
Baseling Window: pt= Sy MilEsiele g"
Peak Start: oo o
A i =
Size Calling Methad Paak End: 0.0 [0)

(:) 2nd Order Least Sguares
() 3rd Order Least Sguares
(:) Cubic Spline Interpolstion
() Local Southern Method
() Global Southern Method

[ Factary Defaults ]

[ox [ comen ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
peak amplitude thresholds for interpretation of data.

Fields include:

¢ Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of
these peaks.

* Size calling method - The Profiler Plus® and Profiler Plus® ID Kits have been
validated using the Local Southern sizing method. Before using other sizing
methods, perform internal validation studies.
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Peak Quality tab

_ Analysis Method Editor - HID %]
settings _
General | Allele | Pesk Detectar | Pesk Quality | Quslity Flags
Perform
Signal level internal
Homozygous min pesk height \ validation
studies to
Heterozygous min peak height .
va P o determine
Heterozygate balance settings

Wlin peak height ratio

Peak morphalogy

L

Mz peak width (basepairs) 15
Pull-up peak
’7Pull-up ratio 0.0s

Allele number

Max expected aleles

’ Factary Defaults ]

[ [ cmen |

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds and the
minimum peak height ratio threshold for interpretation of data.
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Quality Flags tab : : _
. Analysis Method Editor - HID &|
settings =
General | Allele | Peak Detector | Peak Quality | Qualty Flags |
Quality weight= are between 0 and 1.
—Ewalty Flag Settings
Spectral Pull-up 0s Control Concordance 1.0
Broad Peak 0.8 Low Peak Height 0.3
o
Out of Bin Allele Oft-scale né 2
Peak Height Ratio 03 Z
Orverlap N
e
e
@
@
O
n
o
p=1]
£
~PaY Thresholds &}
(0]
Pass Range: Lovwy Giuality Range:
Sizing Quality: From |0.75 ta10 From 0010
Genatype Guality: From | 075 to1.0 From 00to [ 0.25
Factory Defaults
[ QK ] [ Cancel ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values for interpretation of data.

Create size The GeneScan" 500 ROX™ Size Standard for the Profiler Plus® and Profiler Plus® ID
standard Kits uses the following size standard peaks in its definitions: 75, 100, 139, 150, 160, 200,
300, 340, 350, 400, and 450.

Note: The 250-nt peak in the GeneScan"" 500 ROX"" Size Standard is not included in
the size standard definition. This peak can be used as an indicator of precision within a
run.

Use the following procedure to create the appropriate size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, click New, select the Basic or Advanced radio
button, then click OK.

(7] GeneMapper Manager

| Projects | &nalysis Methods | Table Settings | Plot Settings || Matrices | Size Standards l
Marme Last Saved Crpvrer Type Dezcription
| CE_G5_HID_GS500 201 0-09-08 15.04: 3| gmid Basic/Advanced ‘;J

ey . Open.. Save Lz Export... Delete

3. Enter a name (for example, CE_F_HID_GS500 (75-450)). In the Size Standard Dye
field, select Red. In the Size Standard Table, enter the sizes specified in on
page 43. The example below is for the GeneScan'" 500 ROX"" Size Standard.

(#] Size Standard Editor

et

Edit

—=ize Standard Descrigtion

Mame: CE_F_HID_G5500 (75-450) |

Description:

Size Standard Dvyve: Red w

Size Standard Table

Size in Basepairs
1 |750

[

2 |1oo0n

3 1380

4 11500

5 1600

g 2000

¥ |300.0

g |240.0

9 |350.0

10 |400.0

11 (4500

I
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Analyze and edit sample files with GeneMapper® ID Software

Analyze and edit sample files with GeneMapper® ID Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method Profiler_Plus_AnalysisMethod_v1 (or the name of the analysis
method you created)
Panel Profiler_Plus_v2
Size Standard CE_F_HID_GS500 (75-450)" (or the name of the size standard

you created)

+ The Profiler Plus® and Profiler Plus® /D Kits were originally validated using the GeneScan™ 500 ROX™
Size Standard. If you use the GeneScan™ 400 HD Size Standard as an alternative, perform the appropriate
internal validation studies to support the use of this size standard with the Profiler Plus® and Profiler
Plus® /D Kits.

Note: For more information about how the Size Caller works, refer to the
GeneScan® Analysis Software for the Windows® NT Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).

3. Click B (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

¢ The status bar displays the progress of analysis:

— As a completion bar extending to the right with the percentage
indicated

— With text messages on the left

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis.

Project window after analysis

T, Germbapoer 10 v31.3.1 - “Untiied - gmid ks Logged In
Fle BR éndes e Took Heip

Al BE N FWE * & e oo e < Bha = |
= = Pl |-§.n. 2
B [P Pue Tubsx |Sarmpa Fin Sarchbars  [Serch Troe lbuateriz Wrihad Faral Sioe Sarced Mairix  |Fun Haes woinased Typs |520 |[TTE |5@ L
i B |MICEDI D01 Aima  FW_HMO1  Serpk Prafierfhuz_insricklattod_ | Froier_F_vE O o4 _CEmn00T A 50| Frofiar Pz Exsrpls T
H [ Ha_HEE_1_0_N 3_G0E 158 HL_HE_1 0 = ProisrPiis_Ensheussisnon_v1 | Frodier_Pue_ve CE_(h_Gesiiedsn Pridier Pus Exmangls [ ] .
] B |MITCEI D0 DOinm rWHII 1 Serps Praerfuz_snatvozhattod 1 |Froimr_Pu_v2 _G5_GSS000 =450 Frofier Pz Exsrncs ]
& [ Liwiviey (i 2_FUu. 15 Loy i) | puiey ProferPis_tnatpsishietinod_vi | Frofier_Fae_ v E o5 Bl TE-4EDn Frovies P ok ] .
& B |NTC_EOE DM HIT Fiagmives Cantrol PralierPhuz_Snafrsizhisthod w1 |Froier_Fua_v2 CX=E—— ) " @
3 B |Poelerlondol 005 Cldiss  Postkeloeld | Posthe Conkol ProerPius_Bnalpsuiisiige i |Prodier_Pue_v2 (CE {5 _CSEDTE-dEDn m e

I
|2

For more information about any of these tasks, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (Pub. no. 4338775).
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Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:

o GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Pub. no. 4335523)

» GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide
(Pub. no. 4338775)

e Installation Procedures and New Features for GeneMapper® ID Software Software
Version v3.2 User Bulletin (Pub. no. 4352543)
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For more information
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Overview of GeneMapper® ID-X Software

Section 4.2 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa or .hid file. Using GeneMapper® ID-X Software v1.0.1 or higher you can then
analyze and interpret the data from the .fsa or .hid files.

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
Before you start When using GeneMapper® ID-X Software v1.0.1 or higher to perform human

identification (HID) analysis with AmpF(STR® kits, be aware that:

48

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Panel, bin, and
stutter file version

Before using the
software for the
first time

Check panel, bin,
and stutter file
version

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID-X Software.

Use the same analysis files for analysis of data from Profiler Plus® and Profiler
Plus® ID Kits.

The instructions and examples in this section refer to the latest version of panel, bin,
and stutter file available at the time of publication.

Before you use GeneMapper® ID-X Software (v1.0.1 or higher for .fsa files, v1.2 or
higher for .hid files) to analyze data for the first time, you must do the following:

1. Check the version of panel, bin, and stutter files installed with the GeneMapper®
ID-X Software as explained in “Check panel, bin, and stutter file version” below.

2. Check www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software to determine if newer files are
available.

3. If updated files are available, download and import the files into the
GeneMapper® ID-X Software, as explained in “Import panels, bins, and marker
stutter” on page 50.

Note: When downloading new versions of analysis files, refer to the associated
Read Me file for details of changes between software file versions. If you have
validated previous file versions for data analysis, conduct the appropriate
internal verification studies before using new file versions for operational
analysis.

4. Create an analysis method, as explained in “Create an analysis method” on
page 55.

5. Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

6. Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

-_

Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

2. Select Tools » Panel Manager.
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3. Check the version of files imported into the Panel Manager:
(7] Panel Manager
File Edit Bins View

mf ML BN N

B Panel Mansger

a. Select Panel Manager in the navigation pane.

b. Expand the Panel Manager folder and any sub-
folders to identify the analysis file version already
installed for your kit choice.

4. Check the version of files available for import into the
Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder and check the version of panel, bin,
and stutter files installed.

5. If newer versions are available on the website, download and import as described

below.
Import pa nels, To import the Profiler Plus® Kit panel, bin set, and marker stutter from our web site
bins, and marker into the GeneMapper® ID-X Software database:

stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software. Download the file AmpFLSTR
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:
a. Select Panel Manager in the navigation pane.

(7] Panel Manager

File Edit Bins View

mf ML BN N

B Panel Mansger

b. Select File » Import Panels to open the Import
Panels dialog box.

c. Navigate to, then open the AmpFLSTR Analysis
Files GMIDX folder that you unzipped in step 1
on page 50.
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5. Select AmpFLSTR_Panels_v2X (or the version you installed), then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “AmpFLSTR_Panels_v2X”. This folder contains panels for multiple
AmpF(STR® kits and associated markers.

« Import Panels ®
Lookin: EAmpFLSTR Analysis Files GMIDK V| 53 ,_‘?'||EI

Y L] AmpFLSTR_Bins_vzx
{ 2) =

My Recent EIA - .
Documents | ] Reade_AmpFLSTR vz

Desktop

My Documents

(@)
(¢
=)
[©)
<
V)
©°
©
SE
&)
S
x
n
o
=5
b3
L
(0}

g’ Flename:  |AmpFLSTR_Panels_vZi.bxt | [ mport |

My Computer | Files of bype: |,q|| Files v| Cancel

6. Import AmpFLSTR_Bins_v2X.txt:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation pane.

« Panel Manager,
File Edit Bins View Help

WX (W E M W® |ense:|ampriseens_ v | i B B B EH BDEEEEEE

B...d%‘pand Manager Panel Hame Commment

[ AMpFLSTR_MGMSElect_vzy 1 [Cofler_wl.1x rull &

: gAmDFLSTR—NGM—VSX 2 |SEM_Plos_w1.1% il

AMpFLSTR_Panels_w1x

= = MGM_SElect_vz.1% Il

[ AmpFLS TR, Panels_vzy] 3 i n

4 |Identifiler_Plus_w1.1% rll

S |MGEM_v3.1% rll

& | Identifiler_Direct_w1.1%  |null

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Bins_v2X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2X folder.

« Import Bin Set ®
Lok in; E AMpFLSTR. Analysis Files GMIDR v | 5 ,,’:"|| =

i) AmpFLSTR Bins_vex |
L] ArmpFLSTR Panels_vzx
My Recenk QI AmpFLSTR_Stutker_wZx
Locuments | P ReadMe_AmpFLSTR_w2X

8 jie

Desktop

@

My Documents

File name: |&mpFLSTR_Bins_v2X.bxt | [ import |

My Computer | Files of bype: |p||| Files v| Cancel

7. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2X folder.

b. Double-click the Profiler_Plus_v1.1X folder to display the panel information
in the right pane.

» Panel Manager
File Edit Bins ‘Wiew Help

' X O H O W™ enset:|amprstrEns_.. v | lii Ty Il B H HEBER

IE

=R d%b Panel Manager Pael Hame Commert.
L [CAMPFLSTR _MEMSElect_vas 1 Ofiler_wl,1% ndll
(CDAmpFLSTR_NGM 33 2 |SGM_Plus_v1.1% nul
E}“B.ﬂ.mpFLSTR_Panels_vl 3 |NGM_SElect_wz, 1% ndll
4 |Idenkifiler _Plus_v1.1% ndll
---[ESGM_F‘EIS_N JAX S |NGEM_w3 1X ndll
£ [OMGM_SElect_v2. 1% & |Idertifiler_Direct_w1.1% |null
g Ldgh:T:rl_ : lus vl 1% 7 |Profiler_Plus_v1.1X null
- 1dentifiler_Direct_v1.1% 5 |Profiler_v1.1% nul
[ﬁ Profiler_Phus_w1.1% a | SEfiler_Phus_w1.1% rdll
& DProfiler 1.1 10 |Tdenkifiler_vi. 1% nul
gfgg:ﬁ}ﬁzﬁ‘ﬂ;x 11 |MiniFiler_v1. 13 nul
---EMiniFiler_vl 1w 12 |Profiler_Plus_CODIS_wi. 1 {null
W T Prefiler Plie CODTS Wi 1Y 12 IwFiler w1 1% ruill
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8. Select and expand Profiler_Plus_v1.1X in the navigation pane, then select
D851179 to display the Bin view for the marker in the right pane.

»* Panel Manager E]

File Edit Bins View Help
B | (5 MM | U | i St [AmpRSTR Bins_vax v faERE SEEEEEN

EIE) Profiler_Plus_v1.1A
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[ QK H Cancel H Apply H Help ]

9. Import AmpFLSTR_Stutter_v2X:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation panel.

« Panel Manager
File Edit Bins Yiew Help

w X W E ™ snset:|amprsTrEns_ . vl By OB BB

Ly
(=) g5 Panel Manager Panel Hame Commert
[CAmpFLSTR_MGMSEleck w2y 1 Ofiler w1, 1% null =
(D AMpFLSTR_NGM_v3X 2 |SGM_Plus_wl.1% null
5 vl 3 |NGM_SElect_wz.1% nul
4 |Identifiler_Plus_wi.1% null

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the AmpFLSTR_Panels_v2X folder.

« Import Marker, Stutter ®
Look in: E AmpFLSTR. Analysis Filss GMIDH v | 5 ,:J|| =

E_ L AmpFLSTR_Bins _ves

L AmpFLSTR_Panels_va

My Recent (] AmpFLSTR _Skutk
Documents | D] Reade_AmpFLSTR_v2y

Desktop
o

My Documents

T’jj)\g File name: |AmpFLSTR_Stutter_v2:.txt | [ mport |
My Compuker | Files of bype: |.0.II Files v| Cancel

10. View the imported marker stutters in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2X folder to display its list of kits in
the right pane.

b. Double-click the Profiler_Plus_v1.1X folder to display its list of markers
below it.

c. Double-click D21511 to display the Stutter Ratio & Distance view for the
marker in the right pane.

File Edit Bins View Help

B WM M W= onsets AmprlsTR s v v fuESE EESEEEEN o
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[+ DB51179 Ratio Fram Distance Ta Distance Ratio Fram Distance Ta Distance
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Flease enter the stutter filter(s) for D21511 marker here If left blank, the global stutter filter will be applied
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------ B Reference Samples |

11. Click Apply, then OK to add the panel, bin set, and marker stutter to the
GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels,
bin sets, and marker stutter will not be imported into the GeneMapper® ID-X
Software database.
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Create an analysis Use the following procedure to create an analysis method for the Profiler Plus® and
method Profiler Plus® ID Kits.

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

 GeneMapper® ID-X Manager (%]

Find Mame Conkaining:
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Projects | Analysis Methods | Table Settings || Plaot Settings || Matrices | Size Standards | Report Settings

[ Mew... ][ Open... ][ Save As... ][ Import... ][ Export,..

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures below,
unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings (see step 3
on page 55). To complete this step quickly, do not save the analysis method until
you finish entering settings in all of the tabs.

3. Click Save.
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General tab

settings Analysis Method Editor
General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings |
—Analysis Method Description
Mame: |PrDFiIerPIus_ﬂ.naIysisMethDd_u1}( |
Security Group: |GeneMapper ID-X Security Group w |
Descripkion: -
“
Instrument: |
Analysis Type: HID
[ Save ] [ Cancel ] [ Help ]

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software

configuration from the dropdown list. The Description and Instrument fields are
optional.
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Allele tab settings :
g Analysis Method Editor E|

| General | Allele | Peak Detector | Peak Quality | 55 & G0 Settings |

Bin Set: nn-.pFLETF:__E:ins

Use marker-specific stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value 0.0 0.0 0.0 0.0
Minus4 R.atio 0.0 0.0 0.0 0.0
Minusa Distance From 0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0
Global Minus Stutker Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From (0.0 3.25 0.0 0.0
To (0.0 4.75 0.0 0.0
Global Plus Skukter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From (0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0
Amelogenin Cukoff

Range Filter. .. Factory Defaulks

l Save ” Cancel ” Help l

¢ In the Bin Set field, select the AmpFLSTR_Bins_v2X bin set and configure the
stutter distance parameters as shown.

* GeneMapper® ID-X Software v1.0.1 or higher allows you to specify 4 types of
marker repeat motifs: tri, tetra, penta and hexa. You can enter parameter values
for each type of repeat in the appropriate column.

¢ Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Stutter_v2X file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the
appropriate filter setting to use.
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Peak Detector tab
settings

58

Analysis Method Editor (%)

General | Allele Peak Quality | 50 & GQ Settings

Peak, Detection Algorithm: advanced

Ranges Peak Detection
! iy Perform
Analysis Sizing Peak Amplitude Thresholds: internal
Full Range All Sizes w . i X .
B: R: validation
G o: studies to
determine
i settings
Smoothing and Baselining 9
Min. Peak Half Width: | 2 pts
Smoathing () Mane
i : )
® Light Palynomial Degree:
() Heavy Peak Window Size: 15 pts
Baseline Window: 51 pts Slope Threshold
Peak Start: 0.0
rSize Calling Method Peak End: 0.0
() 2nd Order Least Squares

() 3rd Order Least Squares
() Cubic Spling Interpolation
(#) Local Southern Method
() Global Southern Method

Factary Defaults

Save As ” Save ” Cancel ” Help l

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the

minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

Size calling method — The Profiler Plus® and Profiler Plus® ID Kits has been
validated using the Local Southern sizing method. Before using other sizing
methods, perform internal validation studies.

Normalization — A Normalization checkbox is available on this tab in
GeneMapper® ID-X Software v1.2 for use in conjunction with data run on the
Applied Biosystems 3500 Series Genetic Analyzers. Normalization cannot be
applied to 4-dye data, so this feature is not for use with data from Profiler Plus®
and Profiler Plus® ID Kits.
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Peak Quality tab

) Analysis Method Editor, 3
settings - p— =

General | Alele PeakDetectan

ﬂnIMax Peak Height (LPHIMPH) \

Homozygous min peak height I:I Perform
Heterozygous min peak height I:I internal
validation
Max Peak Height {MPH) I:I studies to
determine
settings
Peak. Height Ratio (PHR)

Qﬂ peak height: ratio

Broad Peak (BDY

—
o

Max peak width (basepairs)
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Allele Mumber (AR

Max expected alleles

I

Allelic Ladder Spike

Cut-off Yalue 0.z

[ Factory Defaults

[ Save H Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds,
maximum peak height threshold and the minimum peak height ratio threshold for
interpretation of data.
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SQ & GQ tab
settings

Create size
standard (optional)

60

Analysis Method Editor (%)

Cuality weights are between 0 and 1,
rSample and Control GO Weighting

Broad Peak (BL) 0.5 Allele Mumber (AR 1.0
Dot of Bin Allele (BIN) 0.5 Low Peak Height (LPH) 0.3
Crverlap (OVL) 0.8 Max Peak Height: (MPH) 0.3
Marker Spike (SPK) 0.3 Off-scale (05) 0.8

Peak. Height Ratio (PHR) 0.3

Contral Concordance (ZC) Weight = 1.0 (Only applicable ko contrals)

30 weighting

Broad Peak (BD)

rallelic Ladder G0 weighting
Spike (SSPKJSPE) Off-scale (03)

S0 & G0 Ranges

Sizing Ciuality: From | 0.75 to 1.0 FromO.0ko | 025

Genobype Guality:  From | 0.73 to 1.0 FromO.0ko | 025

Reset Defaulks

I
i
h=]

[ Save As ][ Save ][ Cancel ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to
determine the appropriate values to use.

The CE_F_HID_GS500 (75-450) size standard definition is installed with the software
for use with the Profiler Plus® and Profiler Plus® ID Kits and contains the following
size standard peaks:

GeneScan™ 500 ROX™ Size Standard
75, 100, 139, 150, 160, 200, 300, 340, 350, 400, and 450

Note: The 250-nt peak in the GeneScan'" 500 ROX™" Size Standard is not included in
the size standard definition. This peak can be used as an indicator of precision within a
run.

Use the following procedure if you want to create your own size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, then click New.

Find Mame Containing:

| Projects | Analysis Methods | Table Settings | Plat Settings | Matrices| Size Standards | Repart Settings |

e Qpen... Save As... Irnpork. .. Expork. .. Delete
[ tew... ]
Help Done

3. Enter a name. In the Size Standard Dye field, select Red. In the Size Standard
Table, enter the sizes specified in on page 60. The example below is for the
GeneScan"" 500 ROX™ Size Standard.

Marne Last Saved Cwner Type Description (0)

| CE_F_HID_GS500 (75-400) 2007-05-09 13:23:5 | gmidx Advanced g
| CE_F_HID_G5500 (75-450) 2007-05-09 13:24:0 | gmidx Advanced %
| CE_G5_HID_GS500 2006-10-11 13:12:% | gmids Advanced %
| GS600_LIZ 2007-06-26 10:43:1|grid:x Advanced -8
| GS600_LIZ+Mormalization_{80-400% |2007-06-27 01:43:1|gmid:x Advanced 1@
| ES600_LIZ_(R0-400) 2007-06-27 01:43:1|gmidx Advanced 5

1

>

wn

o

=k

2

)

()

ot Size Standard Editor

Edit
rSize Standard Description
Name: CE_F_HID_G5500 (75-450)
Security Group: |GeneMapper ID-¥ Security Group w
Description: |
| Size Standard Dye: |Red w |
rSize Standard Table
Size in Basepairs
= |
2 (1000
3 |139.0
4 |150.0
5 |160.0
6 |200.0
7 |300.0
8 |340.0
9 |350.0
10 |400.0
11 |450.0

[ QK H Cancel H Help ]
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Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method Profiler_Plus_AnalysisMethod_v1X (or the name of the
analysis method you created)
Panel Profiler_Plus_v1.1X
Size Standard CE_F_GS500 (75-450)T (or the name of the size standard you
created)

t The Profiler Plus® and Profiler Plus® /D Kits were originally validated using the GeneScan™ 500 ROX™
Size Standard. If you use the GeneScan™ 400 HD Size Standard as an alternative, perform the

appropriate internal validation studies to support the use of this size standard with the Profiler Plus®
and Profiler Plus® /D Kits.

Note: For more information about how the Size Caller works, refer to the

GeneScan® Analysis Software for the Windows® NT Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).
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Examine and edit a project

3. Click ™ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

¢ The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed and the Genotypes tab becomes
available upon completion of the analysis.

Analysis summary window after analysis

# GeneMapper® ID-X - Profilen Plus Kit Example - gmidx Is Logged In Database GBOLDROYNJOSE

File Edit Analysis Yiew Tools Admin Help

e E @g @ El J_|_[ @ . w Table Setting: 310 Daka Analysis v| p é & !: aQ

(@)
(0]
=}
(0]
<
Q
e
e)
Q
)]
S
<
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o
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2
(0]

El---dngm]ect 1 Samples | Analysis Summary | Genotypes
- CProfiler Plus Kit Example | |
Analysis Summary
Select run Folder ko display:
Sample Status [ Total # of Samples |
% Unanalyzed 0
Analyzed [
l:]j Analysis Setting Changed i}
Click a link below to display a filtered Samples Table containing only the samples selected.
Allelic Ladder Quality per run folder (based on S0 and CGQ only)
Run Folder ][ Total # of Analyzed Ladders ][ ][ & ][ E
Prafiler Plus Kit Example | 1 | + | «o | o |
Control Quality per project (based on sample PQVs: S05, SS5PK, MIX, OMR, 50, CGQ)
Contral Type [ Total # of Samples [ All thresholds met [ 0 One or more thresholds not met
Pasitive Cantral 1 1 i}
Custom Control 1] 1] 1]
Megative Contral 1 1 i}
Tatal 2 2 o
Sample Quality per project (based on sample POVs: S05, SSPK, MIX, OMR, 50, CGQ)
[ Tokal # of Samples [ Al thresholds met: [ 0 One or more thresholds not met ]
Samples 3 1 z |
< | >

Stop

Analysis Completed.

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

For more information

For more information, refer to:
o GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub. no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)

o GeneMapper® ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Pub. no. 4396773)

o GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub. no. 4426481)
o GeneMapper® ID-X Software Version 1.2 Quick Reference Guide (Pub. no. 4426482)
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Chapter 5 Experiments and Results

Overview

Section 5.1 Developmental Validation of the Profiler

Plus® Kit

Overview

Importance of
validation

Experiment
conditions

This section provides results of the developmental validation experiments we
performed using the Profiler Plus® Kit.

These studies meet or exceed those recommended in the Technical Working Group on
DNA Analysis Methods (TWGDAM) guidelines as well as the DNA Advisory Board
(DAB) Quality Assurance Standards, effective October 1, 1998 (Technical Working
Group on DNA Analysis Methods, 1995; DNA Advisory Board, Federal Bureau of
Investigation, U.S. Department of Justice, 1998). These studies also address the
guidelines outlined in the ENFSI DNA Working Group Quality Assurance Programme
for DNA Laboratories.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

This chapter discusses many of the experiments we performed and provides examples
of results obtained. We chose conditions that produced optimum PCR product yield
and that met reproducible performance standards. It is our opinion that while these
experiments are not exhaustive, they are appropriate for a manufacturer of STR kits
intended for forensic and/or parentage testing use. Each laboratory using the Profiler
Plus® Kit should perform their own internal validation studies.

Developmental validation

DAB 8.1.1
Developmental
Validation

PCR components

66

“Developmental validation that is conducted shall be appropriately documented.” (DNA
Advisory Board, 1998).

Critical reagent concentrations and reaction conditions (such as thermal cycling
parameters, AmpliTaq Gold® DNA polymerase activation, cycle number) to produce
reliable, locus-specific amplification and appropriate sensitivity have been
determined.

The concentration of each component of the Profiler Plus® Kit—Tris-HCl (pH 8.3), KCl,
dNTPs, primers, AmpliTaq Gold® DNA Polymerase, MgCl,, bovine serum albumin,
and sodium azide—was optimized to give the most reliable performance. The optimal
concentration for a particular component was established to be in the middle of a
window that meets the reproducible performance characteristics of specificity and
sensitivity.
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Accuracy, reproducibility, and precision

After the optimal concentration was determined for a single component, the others
were tested sequentially until it was determined that each component was at the
optimal concentration relative to the concentrations of the other components in the
master mix. The optimized Profiler Plus® Kit provides the required degree of
specificity such that it is specific to primates for the species tested (with the exception
of the amelogenin locus, see “Nonhuman studies” on page 81) and does not produce
nonspecific mispriming artifacts.

Thermal cycler Thermal cycling parameters were established for amplification of the Profiler Plus® Kit

parameters in the DNA Thermal Cycler 480 and GeneAmp® PCR Systems 2400, 9600, and 9700.
Thermal cycling times and temperatures met GeneAmp® PCR Instrument
specifications. Annealing and denaturation temperature windows were tested around
each setpoint to verify that a +2°C window (DNA Thermal Cycler 480) or +1.5°C
window (GeneAmp PCR System 2400, 9600, and 9700) yielded specific PCR product
with the desired sensitivity of at least 1 ng of AmpF(STR® Control DNA 9947A.

Profiler Plus® Kit reactions were amplified for 27, 28, 29, and 30 cycles on both the
DNA Thermal Cycler 480 and the GeneAmp® PCR System 9600.
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While none of the cycle numbers tested produced nonspecific peaks, 28 cycles was
found to give optimal sensitivity when the amplified products were examined on
Applied Biosystems instruments. Additionally, the cycle number was set to avoid
detection of low quantities of DNA (35 pg or less). At 28 cycles, 2.0 ng of AmpF(STR®
Control DNA 9947A amplifies reliably and specifically following the conditions
outlined in this manual.

The effects of denaturation and annealing temperatures on the amplification of Profiler
Plus® Kit loci were examined using 1-2 ng of the AmpF(STR® Control DNA 9947A.
The denaturation temperatures tested were 92, 94, and 96°C, all for 1-minute hold
times. The annealing temperatures tested were 57, 59, 61, and 63°C, also for 1-minute
hold times. The majority of these were tested on both the DNA Thermal Cycler 480 and
the GeneAmp® PCR System 9600 and 2400. The PCR products were analyzed using
the Applied Biosystems 377 DNA Sequencer and GeneScan® Analysis 2.1 Software.
Neither preferential nor differential amplification was observed in any of these
denaturation temperature experiments. Of the tested annealing temperatures, 57, 59,
and 61°C did not induce any differential amplification. At 63°C, the yield of the
majority of loci was significantly reduced. This should pose no problem if the thermal
cyclers are calibrated routinely and the recommended amplification protocol is
followed. Preferential amplification was not observed at any of the tested annealing
temperatures.

Accuracy, reproducibility, and precision

DAB 8.1.2 Accuracy  “Novel forensic DNA methodologies shall undergo developmental validation to ensure the
accuracy, precision and reproducibility of the procedure.” (DAB, 1998).

Laser-induced fluorescence detection systems of length polymorphism at short
tandem repeat loci is not a novel methodology (Holt et al., 2001 and Wallin et al., 2001).
However, accuracy and reproducibility of Profiler Plus® Kit profiles have been
determined from various sample types.
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Accuracy, reproducibility, and precision

Accuracy

68

In the following study, body fluids and tissues were collected and DNA extracts were
prepared by the Santa Clara County Crime Laboratory DNA Unit, San Jose, CA. Blood,
saliva, hair, and either a semen sample or a vaginal swab were collected from four
individuals and DNA was extracted following a phenol/chloroform procedure and
stored at the crime laboratory for approximately 1 year at 15 to -25°C. DNA was also
extracted from the brain, kidney, liver, muscle, and skin of a human cadaver using the
phenol/chloroform procedure. Additionally, four individuals contributed blood and
saliva and two individuals contributed blood, saliva, and hair that were processed
using a Chelex DNA extraction protocol and stored at the crime laboratory for
approximately 1 week at 4°C. These thirty samples were amplified using Profiler Plus®
Kit reagents and PCR products were analyzed using an Applied Biosystems 310
Genetic Analyzer and GeneScan® Analysis 2.1 Software. DNA isolated from each of
the different tissues/fluids from each individual yielded the same genotype.

Figure 6 illustrates the size differences that are typically observed between sample
alleles and AmpF(STR® Profiler Plus® Allelic Ladder alleles on the Applied
Biosystems 310 Genetic Analyzer with POP-4® polymer. The x-axis in Figure 6
represents the nominal base pair sizes for a single injection of AmpF(STR® Profiler
Plus® Allelic Ladder, and the dashed lines parallel to the x-axis represent the +0.5-bp
windows. The y-axis is the deviation of each sample allele size from the corresponding
allelic ladder allele size. The data include a total of 542 alleles from 31 population
database samples. In this representative example, all sample alleles are within 0.5 bp of
a corresponding allelic ladder allele.

Figure 6 Size deviation of 31 samples and two allelic ladders from one injection of allelic ladder
on a single Applied Biosystems 310 instrument run.
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The AmpF(STR® Profiler Plus® Allelic Ladder contains the majority of alleles for the
D351358, vWA, FGA, amelogenin, D851179, D21511, D18551, D55818, D135317 and
D75820 loci. However, alleles not found in the AmpF(STR® Profiler Plus® Allelic
Ladder do exist. These “off-ladder” alleles may contain full and/or partial repeat units.
An “off-ladder” allele should flag itself by not falling inside the +0.5 bp window of any
known allelic ladder allele.

Note: If a sample allele peak is found to be >0.5 bp from the corresponding allelic
ladder peak, then the sample must be rerun to verify the result.

Reproducibility The reproducible nature of purified DNA samples from various individuals (>10),
used routinely at Life Technologies, as well as validation samples processed during
characterization of AmpF(STR® PCR Amplification Kits (for example, from body fluid
mixture studies, environmental studies, matrix studies, nonprobative studies, CEPH
family DNA sets) was without exception. All samples yielded the correct genotype.

Precision and size As indicated in the previous section, the recommended method for genotyping is to

windows employ a +0.5-bp “window” around the size obtained for each allele in the
AmpF(STR® Profiler Plus® Allelic Ladder. A +0.5-bp window allows for the detection
and correct assignment of potential off-ladder sample alleles whose true size is only
one base different from an allelic ladder allele. Alleles of all possible sizes (within the
range of 75-400 bp) should be readily identifiable. Any sample allele that sizes outside
a window could be either of the following:
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* An “off-ladder” allele, i.e., an allele of a size that is not represented in the
AmpF(STR® Profiler Plus® Allelic Ladder (go to http://www.cstl.nist.gov/strbase/
for examples of known off-ladder alleles)

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections in one capillary run.

Table 3 on page 70 indicates typical precision results obtained from 31 database
samples and three AmpF(STR® Profiler Plus® Allelic Ladder samples analyzed on the
Applied Biosystems 310 Genetic Analyzer (47-cm capillary, POP-4® polymer,
GeneScan'" 500 ROX"" Size Standard). These results were obtained within a set of
injections on a single capillary.

As indicated above, sample alleles may occasionally size outside of the +0.5-bp
window for a respective allelic ladder allele because of measurement error. The
frequency of such an occurrence is lowest in detection systems with the smallest
standard deviations in sizing. Figure 6 on page 68 illustrates the tight clustering of
allele sizes obtained on the Applied Biosystems 310 Genetic Analyzer, where the
standard deviation in sizing is typically less than 0.15 bp. The instance of a sample
allele sizing outside of the +0.5-bp window because of measurement error is relatively
rare when the standard deviation in sizing is approximately 0.15 bp or less (Smith,
1995).

For sample alleles that do not size within a +0.5-bp window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the allelic ladder.
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It is important to note that while the precision within a set of capillary injections is very
good, the determined allele sizes vary between platforms. Cross-platform sizing
differences arise from a number of conditions, including type and concentration of
polymer mixture, run temperature, and electrophoresis conditions. Variations in sizing
can also be found between runs on the same instrument and between runs on different
instruments because of these conditions. We strongly recommend that the allele sizes
obtained be compared to the sizes obtained for known alleles in the AmpF(STR®
Profiler Plus® Allelic Ladder from the same run and then converted to genotypes (see
“Allelic ladder requirements” on page 25). For more information on precision and
genotyping, see Lazaruk et al., 1998.

Table 3 Example of precision results on a 310 Genetic Analyzer

Allele n Mean S.D.
D351358
12 3 111.34 0.01
13 3 115.51 0.04
14 " 119.43 0.07
15 14 123.42 0.14
15 22 127.48 0.10
17 16 131.62 0.15
18 6 135.75 0.1
19 4 139.96 0.08
VWA
1" 4 154.59 0.05
12 3 158.84 0.07
13 3 163.01 0.02
14 6 167.18 0.12
15 13 171.09 0.07
16 13 175.09 0.05
17 " 179.11 0.06
18 12 183.04 0.05
19 13 187.00 0.09
20 4 190.93 0.08
21 3 194.86 0.04
FGA
18 3 216.23 0.05
19 5 220.27 0.07
20 6 224.28 0.02
21 16 228.30 0.05
24 9 240.41 0.07
25 12 244.50 0.06
26 3 248.53 0.05

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide



Section 5.1 Developmental Validation of the Profiler Plus® Kit 5
Accuracy, reproducibility, and precision

Allele n Mean S.D.
26.2 3 250.56 0.05
27 5 252.61 0.04
28 3 256.67 0.06 9
29 A 260.74 0.07 §
30 3 264.85 0.08 %
Amelogenin %
X 3% 103.44 0.05 g
Y 22 109.12 0.05 =
D8S1179 S
e
8 3 123.68 0.05 S
9 4 127.69 0.02 %
10 6 131.82 0.04 ol
11 7 135.95 0.06 =
12 11 140.22 0.11
13 17 144.77 0.05
14 16 149.24 0.04
15 14 153.64 0.07
16 4 157.98 0.06
17 3 162.13 0.08
18 3 166.25 0.04
19 3 170.33 0.06
D21S11
24.2 3 187.10 0.07
25 3 189.08 0.02
26 3 192.97 0.04
27 8 196.93 0.07
28 14 200.77 0.06
28.2 3 202.76 0.02
29 10 204.73 0.06
29.2 3 206.73 0.04
30 12 208.68 0.05
30.2 5 210.63 0.03
31 7 212.67 0.06
31.2 7 214.57 0.07
32 4 216.61 0.05
32.2 6 218.54 0.06
33 3 220.55 0.05
33.2 5 222.48 0.06
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Allele n Mean S.D.
34 3 224.52 0.02
34.2 3 226.49 0.02
35 6 228.60 0.08
35.2 3 230.45 0.04
36 6 232.46 0.06
38 4 240.42 0.06

D18S51
9 3 270.49 0.06
10 4 274.62 0.02
10.2 5 276.61 0.06
" 4 278.70 0.07
12 5 282.83 0.05
13 5 286.93 0.05
13.2 4 288.97 0.04
14 9 291.03 0.06
14.2 3 293.01 0.06
15 10 295.06 0.02
16 16 299.16 0.06
17 10 303.54 0.05
18 9 307.94 0.05
19 10 312.31 0.04
20 5 316.61 0.04
21 4 320.93 0.04
22 4 325.11 0.02
23 3 329.28 0.09
24 3 333.45 0.04
25 3 337.55 0.01
26 3 341.56 0.06
D55818

7 3 131.32 0.06
8 8 135.40 0.06
9 5 139.61 0.06
10 10 144.04 0.05
" 14 148.47 0.05
12 21 152.85 0.06
13 12 157.13 0.04
14 4 161.39 0.08
15 3 165.41 0.03
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Allele n Mean S.D.
16 3 169.53 0.06
D135317
8 8 205.04 0.02 g
9 A 209.05 0.06 §
10 3 213.03 0.07 %
1 13 217.06 0.09 5
12 25 221.02 0.05 g
13 10 225.01 0.05 %
14 7 229.00 0.05 "
15 3 233.02 0.03 §
D75820 e
T
6 4 256.05 0.05 5@
7 3 260.09 0.08 =
8 12 264.18 0.04
9 8 268.15 0.06
10 22 272.24 0.06
11 14 276.29 0.06
12 12 280.31 0.07
13 6 284.38 0.06
14 3 288.49 0.05
15 3 292.43 0.04

Extra peaks in the electropherogram

Overview Peaks other than the target alleles may be detected on the electropherogram displays.
Described below are several causes for the appearance of extra peaks, including the
stutter product (found at the n—1 repeat unit position), incomplete 3" A nucleotide
addition (found at the n—1 position), and mixed DNA samples.

Stutter prod ucts The PCR amplification of tetranucleotide STR loci typically produces a minor product
peak one repeat unit shorter than the corresponding main allele peak. This is referred
to as the stutter peak or product. Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Such measurements have been made for hundreds of samples at the loci used in
the Profiler Plus® Kit.
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Some of the general conclusions from these measurements and observations are as
follows:

For each Profiler Plus® Kit locus, the percent stutter generally increases with
allele length, as shown in Figure 7 through Figure 9 on page 75 through page 76.
Smaller alleles display a lower level of stutter relative to the longer alleles within
each locus. This is reflected in Figure 7 through Figure 9, where minimal data
points are plotted for some smaller alleles, because stutter was not detected for
many of these samples.

For the alleles within a particular locus, the percent stutter is generally greater for
the longer allele in a heterozygous sample (this is related to the first point above).

Each allele within a locus displays a percent stutter that is quite reproducible; the
average of the standard deviation values measured for each allele at each locus is:
0.6% for D351358, vWA, FGA, D55818, D135317 and D75820, 0.8% for D8S1179,
D21511 and D18551. The expected range of percent stutter for any particular allele
can be estimated as * 3 standard deviations from the mean. For example, if the
percent stutter for a particular allele averages 5% for multiple replicates, and if
the average standard deviation at the allele is 0.5%, then the expected range in
percent stutter for this allele is

(5 +1.5%) = 3.5-6.5%. This range also provides an estimate of the maximum
expected stutter percent for each allele.

The highest percent stutter observed for any D55818, D13S317 or D75820 allele
was <8%, for any D851179 allele <9%, for any D351358, vVWA, FGA or D21S11
allele <10% and for any D18551 allele <13%..

An upper-limit stutter percent interpretational threshold can be estimated for
each locus as 3 standard deviations above the highest percent stutter observed at
the locus (see above two observations). Peaks at the stutter position that are above
this threshold are not expected to be observed in single-source samples and
therefore can be noted for closer examination. The upper-limit threshold values
for each locus are as follows: 9% (D75820), 10% (D5S818 and D135317), 11%
(D351358, vWA and FGA), 12% (D851179), 13% (D21S11) and 16% (D18S51). For
evaluation of mixed samples, see “Mixed samples” on page 77.

The measurement of percent stutter may be unnaturally high for main peaks that
are off-scale. Loading or injecting less of the PCR product will yield accurate
quantitation. See “DNA quantification” on page 19 for information on off-scale
data.
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Figure 7 Stutter percentages for the D351358, VWA, and FGA loci
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Addition of 3" A
nucleotide

76

Figure 9 Stutter percentages for the D55818, D135317, and D75820 loci

9.0
8.0
*
7.
0 R .,
. .
.
6.0
5 4+ ! * * +
2 . 4 . i .. . g .
= 5.0 +
® : $ : z N . .+
c *
840 ¢ M
g * . i * R
& ! 3! 38
3.0 P . { $ e i ‘.
R $ ;!
2.0 H ‘.
$ $ ¢ . fe
1.0 T
. 2
5
0.0
7 8 9101112131415 8 91011121314 6 7 8 91011121314
D5S818 D13S317 D75820

AmpliTaq Gold® enzyme, like many other DNA polymerases, can catalyze the
addition of a single nucleotide (predominately adenosine) to the 3" ends of
double-stranded PCR products (Clark, 1988, Magnuson et al., 1996).This non-template
addition results in a PCR product that is one base pair longer than the actual target
sequence, and the PCR product with the extra nucleotide is referred to as the “+A”
form.

The efficiency of “A addition” is related to the particular sequence of the DNA at the
3" end of the PCR product. The Profiler Plus® Kit includes two main design features
that promote maximum A addition:

* The primer sequences have been optimized to promote A addition.

¢ The last thermal cycling step is 60°C for 45 minutes.

This final extension step gives the AmpliTaq Gold® DNA polymerase extra time to
complete A addition to all double-stranded PCR product. STR systems that have not
been optimized for maximum A addition may have “split peaks”, where each allele is
represented by two peaks one base pair apart (Figure 10).

Figure 10 Split peaks resulting from incomplete A nucleotide addition due to omission of the
45-minute extension step
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Lack of full A nucleotide addition may be observed in Profiler Plus® Kit results when
the amount of input DNA is greater than approximately 5.0 ng. The reason for this is
that more time is needed for AmpliTaq Gold® DNA Polymerase to add the A
nucleotide to all molecules as more PCR product is generated. Amplification of too
much input DNA will also result in off-scale data (see “DNA quantification” on

page 19 for more information on off-scale data).

Mixed samples Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. In the
discussion below, a peak is defined as any peak that is greater than 150 RFU. We
recommend a minimum peak height threshold to avoid typing less than 35 pg of input
DNA (see “Effect of DNA quantity on results” on page 82).

Detection of mixed samples

Each of the following can aid in determining whether a sample is a mixture:
¢ The presence of more than two alleles at a locus

¢ The presence of a peak at a stutter position that is significantly greater in
percentage than what is typically observed in a single-source sample (see “Stutter
products” on page 73 and Figure 7 through Figure 9).

¢ Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided
by the height of the higher peak (in RFU), expressed as a percentage. Mean peak

height ratios and standard deviations observed for alleles in the Profiler Plus® Kit
loci in unmixed population database samples are as follows:

Allele Mean Peak Height Ratio Number of Observations (n)

D351358 93+ 4% 68
VWA 93+5% T4
FGA 93+5% 80
Amelogenin 90 + 6% 46
D851179 92+ 6% 93
D215 91+ 7% 95
D18S51 91+6% 100
D55818 92+ 5% 65
D135317 93+5% 73
D75820 93+ 6% 79

¢ For all 10 loci, the mean peak height ratios indicate that the two alleles of a
heterozygous individual are generally very well balanced. Ratios <70% are rare in
normal, unmixed samples.

If the peak height ratio is <70% for one locus, and there are no other indications
that the sample is a mixture, the sample may be reamplified and reanalyzed to
determine if the imbalance is reproducible. Reproducible imbalance at only one
locus may indicate a mixture of significantly overlapping genotypes. Other
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Extra peaks in the electropherogram

possible causes of imbalance at a locus are degraded DNA, presence of inhibitors,
extremely low amounts of input DNA, or the presence of an allele containing a
rare sequence that does not amplify as efficiently as the other allele. Amplification
and analysis of additional loci may assist in the interpretation of the sample.

Resolution of genotypes in mixed samples
A sample containing DNA from two sources can be comprised (at a single locus) of
any of the seven genotype combinations listed below.
* Heterozygote + heterozygote, no overlapping alleles (four peaks)
¢ Heterozygote + heterozygote, one overlapping allele (three peaks)
* Heterozygote + heterozygote, two overlapping alleles (two peaks)
* Heterozygote + homozygote, no overlapping alleles (three peaks)
¢ Heterozygote + homozygote, overlapping allele (two peaks)
* Homozygote + homozygote, no overlapping alleles (two peaks)
* Homozygote + homozygote, overlapping allele (one peak)
Specific genotype combinations and input DNA ratios of the samples contained in a

mixture determine whether it is possible to resolve the genotypes of the major and
minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Life Technologies instruments provides additional valuable data to aid in
resolving mixed genotypes. This quantitative value is much less subjective than
comparing relative intensities of bands on a stained gel.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from
known reference sample(s).

Limit of detection of the minor component

Mixtures of two DNA samples were examined at various ratios (1:1 to 1:20). The total
amount of genomic input DNA mixed at each ratio was 1 ng.

The samples were amplified in a GeneAmp® PCR System 9600 and were
electrophoresed and detected using an Applied Biosystems 377 DNA Sequencer.

The results of the mixed DNA samples, shown separately in Figure 11 on page 79, are
displayed in Figure 12 on page 80 where sample A was the minor component and
sample B was the major component.
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The genotypes of the samples in Figure 11 are the following:

Genotype
Allele
Sample A (Male) Sample B (Femalle

v
Amelogenin X, Y X, X %
D351358 15,16 15,18 g
VWA 14,16 17,19 c
FGA 24, 26 23, 24 >
QO
D851179 12,13 13,13 5
D21S11 28, 31 30, 33 s
D18S51 12,15 17,19 o
D55818 1, 11 1,13 S
D135317 1, 1 1, 1 é
D75820 7,12 9,10 ®
=

For these 1 ng total DNA mixture studies, the limit of detection is when the minor
component is present at approximately 1/20 of the concentration of the major
component. The limit of detection for the minor component is influenced by the
combination of genotypes in the mixture.

The following figures show the reference samples and the two DNA samples used for

this study:.
Figure 11 Reference samples for mixture study shown in next figure
ﬂm :‘EIIZI Il 20 I1 c0 I1 20 IEI u} I24-IZI .2?0 ISDD
500
T BT VN Y A
1B : Sample & only ] 1G : Sample & only

OO 17 :Sample & only

= BN VIR I

3B : Sample B only OE 26 :Sample B only
O 3Y :Sample B only
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Figure 12 Results of the two DNA samples from previous figure mixed together at defined ratios
and amplified with the Profiler Plus® Kit. The A:B ratios shown are 1:1, 1:3, 1:5, 1:10, and 1:20
(top to bottom). Alleles attributable only to the minor component are highlighted.
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Characterization of loci

DAB 8.1.2.1
Documentation

Nature of the
polymorphisms

80

“Documentation exists and is available which defines and characterizes the locus.” (DAB,
1998).

The primers for the amelogenin locus flank a six-base pair deletion within intron 1 of
the X homologue. Amplification results in 107-bp and 113-bp products from the X and
Y chromosomes, respectively. (Sizes are the actual base pair size according to
sequencing results, including 3' A nucleotide addition.) The remaining Profiler Plus®
Kit loci are all tetranucleotide short tandem repeat (STR) loci. The length differences
among alleles of a particular locus result from differences in the number of 4-bp repeat
units (see Table 1 on page 12).

Alleles in the AmpF(STR® Profiler Plus® Allelic Ladder, alleles containing partial
repeat units, population database, and nonhuman primate DNA samples have been
subjected to DNA sequencing at Life Technologies. In addition, other groups in the
forensic community have sequenced alleles at some of these loci (Nakahori et al., 1991;
Puers et al., 1993; Moller et al., 1994; Barber et al., 1995; Moller and Brinkmann, 1995;
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Barber ef al., 1996; Barber and Parkin, 1996; Brinkmann et al., 1998; Momhinweg et al.,
1998; Watson et al., 1998). Among the various sources of sequence data on the Profiler
Plus® Kit loci, there is consensus on the repeat patterns and structure of the STRs (see
Table 1 on page 12).

Inheritance The Profiler Plus® Kit loci have been validated by family studies in order to
demonstrate their mode(s) of inheritance.

The Centre d’Etude du Polymorphisme Humain (CEPH) has collected DNA from

39 families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al.,1992).

Four CEPH family DNA sets were examined. One and a half nanograms of DNA from
each sample was amplified using the Profiler Plus® Kit, followed by analysis using an
Applied Biosystems Genetic Analyzer. The families examined included #884

(14 offspring), #1340 (eight offspring), #1341 (ten offspring), and #1345 (eight
offspring), representing eighty meiotic divisions. The results confirmed that the loci
are inherited according to Mendelian rules, as has also been reported in the
literature.(Nakahori et al.,1991; Kimpton et al.,1992; Mills et al.,1992; Sharma and Litt,
1992; Li et al.,1993; Straub et al.,1993; Begovich et al., 1992).

Ma pping The Profiler Plus® Kit loci D351358, vIWA, FGA, amelogenin, D851179, D21511,
D18S51, D55818, D135317, and D7S820 have been mapped and the chromosomal
locations have been published (Nakahori ef al., 1991; Mills et al.,1992; Sharma and
Litt,1992; Straub et al.,1993; Barber and Parkin,1996; Hudson, et al., 1995; Green, et al.,
1991). They are listed in Table 1 on page 12.

Population studies Population distribution data of the 9 Profiler Plus® Kit STR loci have been established
in different racial and/or ethnic groups. These loci were amplified and typed for 200
U.S. Caucasian and 195 African-American individuals. For more information
regarding analysis of these samples, see “Population data” on page 90.

Species specificity

DAB 8.1.2.2 “Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).
Species Specificity

Nonhuman studies = Nonhuman DNA may be present in forensic casework samples. The Profiler Plus® Kit
provides the required degree of specificity such that it is specific to primates for the
species tested (with the exception of the amelogenin locus).

The following experiments were conducted to investigate interpretation of Profiler
Plus® Kit results from nonhuman DNA sources.
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Chapter 5 Experiments and Results

Sensitivity

Sensitivity

DAB 8.1.2.2
Sensitivity

Effect of DNA
quantity on results

82

The extracted DNA samples were amplified in Profiler Plus® Kit reactions and
analyzed using the Applied Biosystems 377 DNA Sequencer.

* Primates — Gorilla, chimpanzee, and orangutan (2.5 ng each).
* Non-primates — Mouse, cat, dog, pig, chicken, cow, and horse (50 ng each).

* Bacteria and yeast — Legionella, Escherichia, Listeria, Neisseria, Vibrio, Citrobacter,
Salmonella, Candida, Saccharomyces (equivalent to ~50 ng human DNA), and
Rhodotorula.

The primate DNA samples all amplified, producing fragments within the 75-350 base
pair region (Wallin et al.,1998). The primate samples were subsequently sequenced by
Life Technologies scientists. The data revealed significant sequence homology between
the primate and human DNA for the Profiler Plus® Kit loci.

The bacteria, yeast, mouse, chicken, and horse samples did not yield detectable
product. The dog, pig, and cow samples produced a 103-bp fragment. This 103-bp
fragment was also amplified using the amelogenin primers alone. This confirms
amplification of the product obtained by Buel et al.(1995). The 103-bp fragment is 4 bp
shorter than the primate 107-bp X-specific product (including +A addition).

“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

The amount of input DNA added to the PCR reaction should be 1.0-2.5 ng. The DNA
sample should be quantitated prior to amplification using a system such as the
Quantifiler® Human DNA Quantitation Kit (Part no. 4343895). Figure 13 on page 83
shows the effect of different amounts of AmpF(STR® Control DNA 9947A.

The final DNA concentration should be in the range of 0.05-0.125 ng/uL so that
1.0-2.5 ng of DNA will be added to the PCR reaction in a volume of 20 pL. If the
sample contains degraded DNA, amplification of additional DNA may be beneficial.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in the following:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data)

Off-scale data is a problem for two reasons:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, which results in
poor spectral separation (“pull-up”).

Identification of off-scale peaks and multicomponent analysis are discussed in
“DNA quantification” on page 19 and “About multicomponent analysis” on
page 16.

¢ Incomplete A nucleotide addition

To avoid these issues, the sample can be re-amplified using less DNA.
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DAB 8.1.2.2
Stability

Lack of
amplification of
some loci

Section 5.1 Developmental Validation of the Profiler Plus® Kit
Stability

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the two alleles of a heterozygous individual may occur (Wallin et al.,
1998; Walsh et al., 1992). This is due to stochastic fluctuation in the ratio of the two
different alleles (Sensabaugh et al., 1991). The PCR cycle number and amplification
conditions have been specified to produce peak heights of <150 RFU for a sample
containing 35 pg human genomic DNA (corresponding to ten total allele copies). Peak
heights <150 RFU should be interpreted with caution.

Individual laboratories may find it useful to determine an appropriate minimum peak
height interpretational threshold based on their own results using low amounts of
input DNA.

Figure 13 Effect of amplifying various amounts of AmpF{STR® Control DNA 9947A ranging from
16 pg to 1 ng. Note that the y-axis scale differs in many of these panels.
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“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

As with any multi-locus system, the possibility exists that not every locus will amplify.
This is most often observed when the DNA substrate has been severely degraded or
when the DNA sample contains PCR inhibitors. Because each locus is an independent
marker, results generally can still be obtained from the loci that do amplify.
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Chapter 5 Experiments and Results

Stability

Differential and
preferential
amplification

84

Differential amplification can be defined as the difference in the degree of
amplification of each locus within a co-amplified system, such that one or more loci
may amplify to a greater extent compared to the other loci. Preferential amplification is
used in this guide to describe differences in the amplification efficiency of two alleles
at a single locus and is observed when the peak height ratio between the two alleles is
<70% (see “Mixed samples” on page 77).

Preferential amplification of alleles in systems that distinguish alleles based on length
polymorphisms is most likely to be observed when the alleles differ significantly in
base pair size. Because most Profiler Plus® Kit loci have small size ranges, the potential
for preferential amplification of alleles is low.

DNA samples with FGA alleles in the 300-350 bp range have been observed. One such
DNA sample containing FGA alleles separated by 90 bp (240 and 330 bp) was analyzed
in some of our studies to determine the potential for preferential amplification.

In assessing potential for differential and preferential amplification, the following four
variables were examined:

* Low template copy number
¢ Effect of PCR inhibitor in a DNA sample
* Degraded DNA

* Amplification denaturation and annealing temperatures

Low template copy number

To determine if the amount of input DNA affected either differential or preferential
amplification, varying quantities of two DNA samples were amplified. One nanogram,
0.5 ng, 0.25 ng, 0.125 ng, 0.06 ng, 0.03 ng, and 0.015 ng of AmpF/STR® Control

DNA 9947Aand the sample containing the widespread FGA alleles were amplified
and then analyzed using the Applied Biosystems 377 DNA Sequencer.

No loci in any of the samples tested differentially amplified at any of the ten loci.

The sample with the widespread FGA alleles preferentially amplified the shorter allele
at 0.06 ng input DNA, such that the shorter allele (240 bp) was detected and the longer
allele (330 bp) was not. However, the shorter allele peak height (30 RFU) was
significantly below the recommended minimum threshold of 150 RFU. At 0.25 ng the
FGA alleles of this sample both amplified in equal proportions, and at 0.03 ng both
alleles were no longer detectable.

These data underscore the importance of interpreting single peaks of low fluorescence
signal with caution and on a case-by-case basis.
Effect of inhibitors

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (Akane et al., 1994., DeFranchis et al., 1988). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.
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Section 5.1 Developmental Validation of the Profiler Plus® Kit
Stability

Bovine serum albumin (BSA) can prevent or minimize the inhibition of PCR, most
likely by binding to the inhibitor (Comey et al., 1994). Since the presence of BSA can
improve the amplification of DNA from blood-containing samples, BSA has been
included in the AmpF(STR® PCR Reaction Mix at a concentration of 8 ug per 50 pL
amplification. BSA has also been identified as an aid in overcoming inhibition from
samples containing dyes, such as in denim.

To examine the effects of hematin on the Profiler Plus® Kit amplification results, DNA
samples were amplified using the Profiler Plus® Kit reagents (including the
BSA-containing PCR reaction mix) in the presence of varying concentrations of
purified hematin. The concentrations of hematin used were 0 pM, 20 uM, 22 uM,

28 uM, and 30 uM. When the amount of hematin was increased to a concentration that
started to inhibit the PCR, D75820 and D18551 were the first loci to drop out in each
experiment, followed by FGA (Figure 14).

Figure 14 DNA amplified with the Profiler Plus® Kit in the presence of varying concentrations
of hematin: 20 uM, 22 uM, 26 uM, and 30 uM
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Degraded DNA

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced. This is due to the reduced number of
intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential amplification of
loci. High molecular weight DNA was incubated with the enzyme DNase I for varying
amounts of time. The DNA was examined by agarose gel analysis to determine the
average size of the DNA fragments at each timepoint. Gel analysis results of the
degraded DNA are shown in Figure 15.
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Figure 15 Agarose gel of degraded genomic DNA
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Four (4) ng of degraded DNA (or 2 ng undegraded DNA) was amplified using the
Profiler Plus® Kit (all 10 primer pairs together) and also in reactions containing each

locus-specific primer pair individually.

The electropherograms in Figure 16 show the Profiler Plus® Kit amplification results of
a DNA sample with no DNase I treatment (1.5 ng amplified) and those of the 30-
second, 1-, 4-, and 8-minute incubations (approximately 4 ng amplified).
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Figure 16 Amplifications of DNA incubated for various times with DNase |
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The loci failed to amplify in the order of decreasing size as the extent of degradation
progressed: D18551 was the first locus to drop out, followed by FGA, and so forth. A
similar result at each timepoint was obtained whether the DNA samples were

amplified for each locus alone or co-amplified with the Profiler Plus® Kit (Figure 17).
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Figure 17 Multiplex and single-locus amplifications of the DNA sample incubated for 1 minute
with DNase |
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When degraded DNA is suspected to have compromised amplification of one or more
loci, the molecular weight of the DNA can be assessed by agarose gel analysis. If the
DNA is degraded to an average of 400 bp in size or less, adding more DNA template to
the Profiler Plus® Kit amplification reaction can help produce a typeable signal for all
loci. Adding more DNA to the amplification provides more of the necessary size
template for amplification.

Analysts at the Santa Clara Crime Laboratory prepared a panel of blood and semen
specimens deposited on a variety of commonly encountered substrates. Blood samples
from two donors were deposited individually on wool, cotton, nylon, metal, glass,
leather (one donor), and blue denim. Semen samples from two donors were deposited
on wool, cotton, nylon, leather, blue denim, acetate, vinyl upholstery, facial tissue, a
condom with spermicide (5% nonoxynol-9), a condom with water soluble lubricant,
and a latex glove.
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Specimens were stored at room temperature and at specified time points a sampling of
each stain was removed for extraction. The blood and semen stains were extracted
using the organic extraction procedure. Additionally, a portion of each blood specimen
was extracted using the Chelex® method followed by Centricon™-100 ultrafiltration.
Extracted samples were then stored at —15 to -25°C for 3—4 years.

The 1-week and 1-year time points were analyzed by Life Technologies scientists. The
samples were amplified using Profiler Plus® Kit reagents and analyzed using the
Applied Biosystems 310 Genetic Analyzer. A complete 10-locus genotype was
obtained for all 36 of the blood and semen samples exposed to the tested matrices for
1 week or 1 year.

Mixture studies

DAB 8.1.2.2
Mixture Studies

Analysis of sexual
assault DNA
mixture evidence

“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Profiler Plus® Kit reactions with DNA extracted from adjudicated and non-probative
sexual assault evidence were examined to assess the performance of the Profiler Plus®
Kit on typical casework samples comprised of mixed body fluids. These samples were
extracted, amplified, and analyzed in collaboration with the Santa Clara County Crime
Laboratory.

DNA extracts from four adjudicated sexual assault cases were prepared by DNA
analysts at the Santa Clara County Crime Laboratory. Sexual assault evidence
materials were processed using the differential lysis and organic extraction procedure,
while victim/suspect reference blood samples were processed using the Chelex®
extraction procedure. Following amplification with the Profiler Plus® Kit reagents, the
PCR products were analyzed using the Applied Biosystems 377 DNA Sequencer.

¢ Case 1 and Case 2 contained a victim reference blood sample, a suspect reference
blood sample, and a victim vaginal swab. The Profiler Plus® Kit genotype of the
epithelial cell fraction was the same as that of the victim reference and did not
contain alleles foreign to the victim. The Profiler Plus® Kit genotype of the sperm
cell fraction did not contain detectable epithelial cell fraction DNA and included
the suspect as a possible semen donor.

¢ Case 3 contained a victim reference blood sample and a victim vaginal swab. The
Profiler Plus® Kit genotype of the epithelial cell fraction was the same as that of
the victim reference and did not contain alleles foreign to the victim. In
accordance with the victim’s account, Profiler Plus® Kit genotypes of the sperm
fraction revealed DNA from multiple semen donors. No suspect(s) were
developed in this case.

* Case 4 contained victim and suspect reference samples and a victim vaginal swab.
The Profiler Plus® Kit genotype of the epithelial cell fraction was the same as that
of the victim reference and did not contain alleles foreign to the victim. The major
sperm fraction genotype included the suspect. A minor genotype, attributable to
carryover from the epithelial cell fraction, was present in the sperm fraction.
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Chapter 5 Experiments and Results

Population data

Limit of detection
of the minor
component

Simulation of forensic casework scenarios was achieved by combining various body
fluids (blood:blood, semen:blood, saliva:blood, and semen:saliva) from two donors in
defined ratios, by volume, from 1:1-1:50.

Mixed stains were prepared and DNA was extracted at the Santa Clara County Crime
Laboratory, San Jose, CA, following the phenol/chloroform procedure (differential
lysis was performed on stains containing semen). At Applied Biosystems
approximately 3 ng of DNA was amplified from each dried fluid mixture in a
GeneAmp PCR System 9600 and detected using the Applied Biosystems 310 Genetic
Analyzer.

The limit of detection of the minor genotype component of each body fluid mixture
ratio was determined. The limit of detection is defined here as the ratio below which a
mixture is not recognized but rather appears to contain DNA from a single source (the
major contributor of the mixture). The limit of detection occurred in blood:blood
mixtures when the minor component was present at one tenth the volume of the major

genotype.

In epithelial cell fractions of differential extractions of semen:blood or semen:saliva
stains, blood and saliva were detectable at one tenth the volume of semen. Sperm DNA
carryover into the epithelial cell fraction of these stains was detectable at one-tenth the
volume of blood or saliva. In sperm fractions, the male genotype was detectable from
every semen:blood or semen:saliva mixture with no trace of the female DNA.

Note that the limit of detection for the minor component is influenced by the specific
combination of genotypes present in mixtures.

Population data

DAB 8.1.2.3
Population Data

DAB 8.1.2.3.1
Population
Distribution Data

Overview

90

“Population distribution data are documented and available.” (DAB, 1998).

“The population distribution data would include the allele and genotype distributions for the
locus or loci obtained from relevant populations. Where appropriate, databases should be tested
for independence expectations.” (DAB, 1998).

To interpret the significance of a match between genetically typed samples, it is
necessary to know the population distribution of alleles at each locus in question. If the
genotype of the relevant evidence sample is different from the genotype of the
suspect’s reference sample, then the suspect is “excluded” as the donor of the
biological evidence tested. An exclusion is independent of the frequency of the two
genotypes in the population.

If the suspect and evidence samples have the same genotype, then the suspect is
“included” as a possible source of the evidence sample. The probability that another,
unrelated, individual would also match the evidence sample is estimated by the
frequency of that genotype in the relevant population(s).
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Population data

Population The Profiler Plus® Kit was used to generate the population data provided in this
samples used in section. Samples were collected from individuals throughout the United States with no
these studies geographical preference.
Population Number of samples Samples provided by
African-American 195 Laboratory Corporation of America
U.S. Caucasian 200

Allele freq uencies Table 4 shows the Profiler Plus® Kit allele frequencies in two populations, listed as
percentages.

Table 4 Profiler Plus® Kit allele frequencies

@)
@
<
o
(®]
©
3
@
=]
=3
L
5
(o)
(V)
=
o
=)
1
i)
=
o
=2
()
=
3
c
(7]
)
2
—

Allele African-American U.S. Caucasian
(n=195) (n = 200)
D351358
? 0.26 t
10 t +
11 0.26% 0.25"
12 0.51% 0.25"
13 f 050"
14 | 11.80 11.25
15 27.95 28.25
15.2 0.26" T
16 32.31 22.25
17 | 21.80 22.25
18 4.62 14.50
17 i 0.50*
VWA

1 0.26" t
12 t +
13 1.54 T
14 7.70 8.50
15 | 22.05 8.25
16 26.92 19.75
17 16.92 25.00
18 1385 25.75
19 | 8.46 11.00
20 2.05 1.50
21 i 0.25
22 0.26 t

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide 91



5 Chapter 5 Experiments and Results
Population data

African-American

U.S. Caucasian

Allele (n=195) (n = 200)
FGA
16.2 0.267 T
17 0.26% t
18 0.51% 1.50
19 4.62 6.25
19.2 0.267 T
20 4.36 16.25
20.2 T 0.75
21 13.33 17.75
21.2 0.267 T
22 18.97 16.50
22.2 0.26% 0.507
23 18.97 14.00
24 16.41 13.25
25 12.31 11.25
26 4.10 1.50
26.2 T T
27 4.10 0.507
28 0.77t t
29 0.26% T
30 T t
D851179
8 t 1.75
9 0.51% 1.00t
10 3.08 8.00
" 4.36 6.25
12 10.51 14.25
13 19.74 34.75
14 33.33 18.75
15 21.03 13.00
16 6.41 2.00
17 1.03% 0.257
18 T t
19 T T
D21S11
24.2 T 0.507
25 T t
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Population data

African-American

U.S. Caucasian

Allele (n = 195) (n = 200)
2 0.26" t
27 5.90 3.75
28 21.80 16.25

28.2 t t
29 20.00 20.75
29.2 t 0.50"
29.3 0.261 t
30 16.15 26.25
30.2 256 250
31 8.97 5.50
312 5.90 10.50
32 0.7t 1.25t
322 6.92 7.25
33 051t 0.251
33.1 0.261 t
332 410 4.00
34 0.26" t
34.2 t 0.75"
35 3.59 t
352 t t
36 154 t
38 0.261 t
D18S51
9 + 1
10 0.517 0.50"
10.2 0511 t
¥ 154 2.00
12 5.64 14.25
13 410 15.00
13.2 0511 t
14 6.67 16.75
14.2 0511 t
15 17.69 14.25
16 17.44 14.00
17 16.41 10.50
18 11.03 6.00
19 10.26 3.75
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Population data

Allele African-American U.S. Caucasian
(n =195) (n = 200)
20 4.87 1.50
21 . 1.03t 1.00t
22 1.03t 025t
23 0.26% 025t
24 t T
25 ' t T
26 t +
D55818
7 0.26 0.25"
8 | 5.13 050t
? 2.05 295
10 7.4k 6.75
n 25.39 3925
12 | 32.56 13.25
13 24.87 16.50
14 2.05 1.00t
15 0.26 t
16 | f 0.25"
D135317
5 i 0.25¢
8 3.59 11.50
9 | 2.31 775
10 231 6.75
n 27.18 3125
12 44.36 28.25
13 | 14.10 975
14 6.15 4.25
& i 0.25
D75820
6 0511 t
63 f 0.25"
7 i 250
8 17.95 17.50
7 | 11.80 13.00
10 | 33.59 24.00
M 22.82 23.00
12 9.49 16.00
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Allele African-American U.S. Caucasian
(n=195) (n = 200)
13 3.59 2.75
14 | 0.26t 075
" f 0.25"

T A minimum allele frequency of 1.3% is suggested by the National Research Council in forensic calculations
using either of these African American or U.S. Caucasian databases analyzed using the Profiler Plus® Kit.

Analyzing the two databases

Analysis across both databases of 790 total chromosomes revealed a total of 11
different D3S1358 alleles, 11 different vWA alleles, 18 different FGA alleles, 10 different
D8S1179 alleles, 20 different D215S11 alleles, 17 different D18S51 alleles, 10 different
D5S818 alleles, 9 different D13S317 alleles, and 11 different D75820 alleles.

In addition to the alleles that were observed and recorded in the Applied Biosystems
databases, other known alleles (listed in Table 1 on page 12) have either been
published or reported to us by other laboratories.
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Independent allele frequencies

Independence of allelic frequencies within a locus can be expressed by the Hardy-
Weinberg (HW) relationship. Approximation of HW expectations in a sample
population allows estimation of genotypic frequencies (HW proportions) from
observed allelic frequencies using the HW equation (expanded binomial square law)
(Hartl and Clark, 1989; Weir, 1996).

Several biostatistical tests were used to survey HW relationships at the Profiler Plus®
Kit STR loci in each sample population. Independence was found between alleles
within each locus, as p values >0.05 were obtained from the homozygosity test
(Chakraborty et al., 1988; Nei and Roychoudhury, 1974; Nei, 1978), likelihood-ratio test
(Edwards et al., 1992; Weir, 1992), and Guo-Thompson exact test (Guo and Thompson,
1992).

Additionally, allele frequency data were analyzed for independence based on the total
number of observed distinct homozygous and heterozygous genotype classes (Nei,
1978; Chakraborty et al., 199). Observed values were within two standard errors of
expected values for each locus. These sets of data demonstrate that appropriate
estimations of Profiler Plus® Kit genotype frequencies are generated from allele
frequencies observed in the Life Technologies African-American and U.S. Caucasian
databases.

Random association

Existence of random association (linkage equilibrium) between all 10 STR loci was
established through two separate statistical tests. Results of the first test, which
considers the observed variance of the number of heterozygous loci (Brown et al., 1980;
Budowle et al., 1995) indicate that in both population samples, all Profiler Plus® Kit loci
are inherited independently.
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Chapter 5 Experiments and Results

Probability of identity

Pairwise interclass correlation tests were performed between every possible two-locus
combination across the African-American and U.S. Caucasian databases (Karlin ef al.,
1981). Mendelian behavior between the nine STR loci was observed. Profiler Plus® Kit
multilocus genotype frequency estimates may be derived through direct
multiplication of each single-locus genotype frequency (the “product rule”) estimated
from the Applied Biosystems African-American and U.S. Caucasian databases.

Low frequency alleles

Some alleles of the Profiler Plus® Kit loci occur at a low frequency (less than five times
in either database). For these alleles, a minimum frequency of 0.013 (five divided by
2n, where n equals the number of individuals in the database) was assigned for the
Profiler Plus® Kit African-American and U.S. Caucasian databases, as suggested in the
1996 report of the Committee on DNA Forensic Science (National Research Council,
1996). These databases are summarized in Table 4 on page 91. The minimum
reportable genotype frequency at each locus is then 1.69 X 1074, giving a minimum
combined multilocus genotype frequency of

1.12 X 10-34 for both the African-American and U.S. Caucasian databases.

Probability of identity

96

Table 5 shows the Probability of Identity (Py) values of the Profiler Plus® Kit loci
individually and combined.

Table 5 Probability of Identity values for the Profiler Plus® Kit STR loci

Locus African-American U.S. Caucasian
D351358 0.102 0.078
VWA | 0.058 ' 0.065
FGA 0.035 0.036
D8S1179 | 0.075 ” 0.067
D21511 0.033 0.045
D18551 | 0.028 ' 0.030
D55818 0.097 0.140
D135317 | 0.131 ” 0.074
D75820 0.081 0.061
Combined 1.48 x 10~ 1.04 x 1071

The P; value is the probability that two individuals selected at random will have an
identical Profiler Plus® Kit genotype (Sensabaugh, 1982). The P; values for the
populations described in this section are then approximately 1/6.8 X 1010 (African-
American) and 1/96 X 1010 (U.S. Caucasian).

Of 18,915 and 19,900 pairs of Profiler Plus® Kit profiles represented by the African-
American and U.S. Caucasian databases, respectively, no 9-locus matches were
observed.
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Section 5.1 Developmental Validation of the Profiler Plus® Kit
Probability of paternity exclusion

Linkage disequilibrium between the Profiler Plus® Kit loci and the AmpF(STR®
Green I loci (THO1, TPOX, and CSF1PO) was not detected. The combination of these
12 AmpF(STR® loci offers an average probability of identity of approximately 1/
1.18 x 1014 (African-American) and 1/2.52 x 1014 (U.S. Caucasian).

Probability of paternity exclusion

Table 6 shows the Probability of Paternity Exclusion (Pg) values of the Profiler Plus®
Kit STR loci individually and combined.

Table 6 Probability of paternity exclusion values for the Profiler Plus® Kit loci

Locus African-American U.S. Caucasian
D351358 0.5260 0.5797
VWA 0.6394 0.6170
FGA 0.7202 0.7173
D8S1179 0.5930 0.6128
D21S11 0.7281 0.6835
D18S51 0.7518 0.7414
D55818 0.5375 0.4554
D13S317 0.4725 0.5948
D75820 0.5742 0.6307
Combined 0.999989 0.999982

The Pg value is the probability, averaged over all possible mother-child pairs, that a
random alleged father will be excluded from paternity after DNA typing of the Profiler
Plus® Kit STR loci (Chakraborty and Stivers, 1996).
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Chapter 5 Developmental Validation of the Profiler Plus® ID Kit
Developmental validation

Section 5.2 Developmental Validation of the Profiler

Plus® ID Kit

Developmental validation

DAB 8.1.1
Developmental
Validation

PCR components

98

“Developmental validation that is conducted shall be appropriately documented.” (DNA
Advisory Board, 1998).

Critical reagent concentrations and reaction conditions (such as magnesium chloride
concentration, thermal cycling parameters, AmpliTaq Gold® DNA polymerase
activation, cycle number) to produce reliable, locus-specific amplification and
appropriate sensitivity have been determined.

The concentration of D851179 degenerate primer of the AmpF(STR® Profiler Plus ® ID
Primer Set was examined. The concentration for the D851179 degenerate primer was
established to be in the window that meets the reproducible performance
characteristics of specificity and sensitivity. After establishing the optimum unlabeled
D851179 degenerate primer concentration, all experiments were performed at that
concentration. Varying magnesium chloride concentrations were also tested to
determine the optimum concentration (Figure 18).

Figure 18 A 2 ng amplification of AmpF(STR® Control DNA 9947A varying the magnesium
chloride concentration, analyzed on the Applied Biosystems 310 Genetic Analyzer
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Thermal cycler

parameters

Section 5.2 Developmental Validation of the Profiler Plus® ID Kit
Developmental validation

Thermal cycling parameters were established for amplification of the Profiler Plus® ID
Kit on the GeneAmp® PCR Systems 9700 run in 9600 emulation mode. Varying
annealing temperature windows were tested to verify that a +2.0°C window produced
a specific PCR product with the desired sensitivity of at least 2 ng of AmpF(STR®
Control DNA 9947A.

The effects of annealing temperatures on the amplification of Profiler Plus® ID Kit loci
were examined using AmpF(STR® Control DNA 9947A and two DNA samples with
one mutant D8S1179 allele.

The annealing temperatures tested were 55, 57, 59, 61, and 63°C (see Figure 19) for
1-minute hold times in the GeneAmp PCR System 9700. The PCR products were
analyzed using the 377 Genetic Analyzer.

Figure 19 An amplification of 2 ng AmpF{STR® Control DNA 9947A, amplified with the Profiler
Plus® /D Kit while varying the annealing temperature, analyzed on the Applied Biosystems 310
Genetic Analyzer
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Chapter 5 Developmental Validation of the Profiler Plus® ID Kit

Species specificity

Species specificity

DAB 8.1.2.2
Species Specificity

Nonhuman studies

100

“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

Nonhuman DNA may be present in forensic casework samples. The Profiler Plus® ID
Kit provides the required degree of specificity such that it is specific to primates for the
species tested (with the exception of the amelogenin locus).

The following experiments were conducted to investigate interpretation of Profiler
Plus® ID Kit results from nonhuman DNA sources.

The extracted DNA samples were amplified in Profiler Plus® ID Kit reactions and
analyzed using the Applied Biosystems 310 DNA Sequencer.
* Primates — Gorilla, chimpanzee, and orangutan, and macaque (1.0 ng each).
* Non-primates — Mouse, cat, dog, pig, chicken, cow, and horse (2.5 ng each).
* Bacteria and yeast — Escherichia and Saccharomyces (1-2.5 ng each).

The primate DNA samples all amplified, producing fragments within the 100-400 base
pair region (Wallin et al.,1998; Lazaruk et al., 2001).

The bacteria, yeast, mouse, chicken, cow, and cat samples did not yield detectable
product. The dog, pig, and horse samples produced a a fragment near the Amelogenin
locus in JOE™ dye (see Figure 20 on page 100.

Figure 20 Representative electropherograms of a primate, non-primates, a microorganism, and
a negative control are shown. All samples were analyzed on an Applied Biosystems 310

Genetic Analyzer. The peaks depicted in red are the GeneScan'"-500 ROX™ size standard.

MR jsc  joo 120 1400 180 180 200 220 E40 260 280 SO0 SO 540 ’
2000 3 I
;J||||||_E Chlmp
1000 ]

ol ba 4 dbda ad wu | i Ly
2000 - '
20003 h Horse
1000 3

0l [ i | i i "l|’
'-Hlllllg L
écu:u:u_; Pig
s Add } i A i |
5000 I
2000 ] Dog
s I L4 A i | i n!‘
SDDD_: 1
?Egg' E. coli

03 i ibd ok i I i i ll!|
EEEE Negative
1||||:::_E J!I jlll J'I ,f\ J'[ ||'I .|'|. Inlcontrol

|

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide



Section 5.2 Developmental Validation of the Profiler Plus® ID Kit
Sensitivity

Sensitivity

DAB 8.1.2.2 “Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).
Sensitivity

Effect of DNA The amount of input DNA added to the PCR reaction should be 1.0-2.5 ng. The DNA

guantity on results sample should be quantitated prior to amplification using a system such as the
Quantifiler® Human DNA Quantitation Kit (Part no. 4343895). Figure 21 on page 101
shows the effect of different amounts of AmpF(STR® Control DNA 9947A.

The final DNA concentration should be in the range of 0.05-0.125 ng/uL so that
1.0-2.5 ng of DNA will be added to the PCR reaction in a volume of 20 pL. If the
sample contains degraded DNA, amplification of additional DNA may be beneficial.

The PCR cycle number and amplification conditions have been specified to produce
low peak heights for a sample containing 35 pg human genomic DNA. Low peak
heights should be interpreted with caution.

Individual laboratories may find it useful to determine an appropriate minimum peak
height interpretational threshold based on their own results using low amounts of
input DNA.

Figure 21 Effect of amplifying various amounts of AmpF(STR® Control DNA 9947A ranging from
16 pg to 1 ng. Note that the y-axis scale differs in many of these panels.
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DAB 8.1.2.2 See “Stability” on page 83.

Stability
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Chapter 5 Developmental Validation of the Profiler Plus® ID Kit

Mixture studies

Mixture studies

DAB 8.1.2.2 “Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).
Mixture Studies

Limit of detection Mixtures of two DNA samples (Sample A = male, Sample B = female) were amplified
of the minor at various ratios (1:1 to 1:10) with the Profiler Plus® ID Kit. The total amount of
component genomic input DNA mixed at each ratio was 1 ng.

The samples were amplified in a GeneAmp PCR System 9700 and were
electrophoresed and detected using an Applied Biosystems 310 Genetic Analyzer.

The results of the mixed DNA samples are shown in Figure 22, where sample A and
sample B were mixed according to the ratios listed.

Figure 22 Results of Sample A to Sample B mixtures. The mixture profiles below highlight the
alleles attributable to the minor component, even when the major component shares an allele.
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Section 5.2 Developmental Validation of the Profiler Plus® ID Kit
Population data

The profiles of the samples in Figure 22 are listed below.

Profile

Allele
Sample A Sample B o
Amelogenin XY X é
D351358 15,16 15, 18 E
D55818 1 11,13 %
D75820 7,12 9,10 s
D8S1179 ' 12,13 13 §
D135317 11 1 5
D18S51 12,15 17,19 a
D21511 28, 31 30, 32.2 5
FGA ' 24, 26 23.2, 24 2
VWA 14,16 17,19 <
X

For these 1-ng total DNA mixture studies, the limit of detection is when the minor
component is present at approximately one-tenth of the concentration of the major
component and a threshold of 50 RFU. The limit of detection for the minor component
is influenced by the combination of genotypes in the mixture.

Population data

DAB 8.1.2.3 “Population distribution data are documented and available.” (DAB, 1998).
Population Data

Population The Profiler Plus® Kit was used to generate the population data provided in
samples used in “Population data” on page 90 for 195 African Americans and 200 Caucasians.
these studies Homozygous samples at the D8S1179 locus were reamplified using the Profiler

Plus® ID Kit to confirm the homozygosity at this locus. Of the 68% African American
and the 60% Caucasian homozygous samples at the D8S51179 locus available for re-
testing, all samples typed as homozygotes. None of these samples were found to be
heterozygous using the Profiler Plus® ID Kit. For allele frequencies in the African
American and Caucasian populations (Holt et al., 2001), see Table 4 on page 91.
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Overview

Section 5.3 Performance Validation After Buffer and
Enzyme Component Replacement

Overview

Experiments

104

As part of an ongoing program to exercise greater control over raw materials used in
the AmpF(STR® PCR Amplification Kits, manufacturing of the AmpliTaq Gold®
enzyme and 10X PCR Buffer II (Tris-KCl buffer) components is transitioning from
Roche Molecular Systems to Life Technologies. Manufacturing of both components by
Life Technologies will be conducted according to the same specifications used
previously by Roche. The in-house components are established raw materials in our
next generation kits (for example, the NGM™, NGM SElect and Identifiler® Plus
Kits).

We performed studies to compare the performance of the Profiler Plus® Kit containing
the in-house components (updated kit) with the performance of the original kit,
focusing on studies most relevant to forensic DNA testing (see SWGDAM Guidelines
effective January 1, 2011). Because of the similarity between the Profiler Plus® and
Profiler Plus® ID Kits, the results generated with the Profiler Plus® Kit can be
considered representative of expected performance of the Profiler Plus® ID Kit. These
studies, while not exhaustive, are in our opinion appropriate for a manufacturer.

Additional studies were performed with inhibited samples using the AmpF(STR®
SGM Plus' Kit and represent the expected performance for 4-dye chemistries. Refer to
the AmpFtSTR® SGM Plus™ Kit User Guide (Pub. no. 4309589) for further details.

Our studies compared the performance of two Roche-manufactured enzyme and
buffer lots (Control mixes) with three new lots of buffer and two new lots of enzyme
manufactured by Life Technologies (Test mixes). Studies were performed using Test
mixes containing both the enzyme and buffer manufactured by Life Technologies.

Test_ Control Amix | Control B mix | Test A mix Test B mix Test C mix
Material
Buffer Control Buffer | Control Buffer | Test Buffer Test Buffer Test Buffer
Lot 1 Lot 2 Lot 1 Lot 2 Lot 3
Enzyme Control Control TestEnzyme | Control TestEnzyme
Enzyme Enzyme Lot 1 Enzyme Lot 2
Lot 1 Lot 2 Lot 2
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Section 5.3 Performance Validation After Buffer and Enzyme Component Replacement
Sensitivity study

Each of the five mixes listed above were used to conduct reproducibility and
sensitivity studies. All amplifications were performed using a GeneAmp® PCR System
9700 with either silver or gold-plated silver block using the recommended
amplification conditions and cycle number for the Profiler Plus® Kit. All data was run
on an Applied Biosystems 3130x/ Genetic Analyzer running Data Collection Software
v3.0 and analyzed using GeneMapper® ID-X Software. Subsequent data analysis was
performed using Minitab® Statistical Software.

Sensitivity study

For the sensitivity study, dilution series of three genomic DNA samples were
amplified: 2 ng (three replicates), 1 ng, 0.5 ng, and 0.25 ng (four replicates each). The
results were evaluated for mean peak height, degree of linearity between input DNA
concentration and peak height, level of allelic dropout at 250 pg, and genotype
concordance.

Mean peak height Mean peak height observations were consistent between all Test and Control mixes
(Figure 23) demonstrating equivalent performance (Figure 24).
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Figure 23 Sensitivity study: mean peak heights three genomic DNA samples
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Sensitivity study

Figure 24 Sensitivity study: representative electropherograms for Sample 2 amplified using
250 pg input DNA (Y-scale 500 RFU)
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DNA concentration The calculated slope and R2 values for each of the plotted curves are equivalent,
and peak height showing comparable relationships between peak height and DNA input amount for
the Test and Control mixes (Figure 25).

Figure 25 Sensitivity study: linear regression plot of combined mean peak height for three
genomic DNA samples
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Section 5.3 Performance Validation After Buffer and Enzyme Component Replacement
Conclusions

Allelic dropout No allelic dropout was observed for any of the Test or Control mixes.

Genotype Genotypes for Test and Control mixes were 100% concordant (Table 7). CE
concordance Table 7 Sensitivity study: genotype concordance §
DNA Input Amount Reagent Mix Genotype Concordance §
250 pg Test A 100% g
Test B 100% =
Test C 100% i
Control A 100% %
Control B 100% 5
500 pg Test A 100% g‘
Test B 100% fgb
Test C 100% D
Control A 100% g
Control B 100% 3
1ng Test A 100% =

Test B 100%

Test C 100%

Control A 100%

Control B 100%

2 ng Test A 100%

Test B 100%

Test C 100%

Control A 100%

Control B 100%

Conclusions

Laboratories can expect to obtain equivalent quality profiles across a wide range of
forensic samples when using the Profiler Plus® and Profiler Plus® ID Kits containing
the AmpliTaq Gold® enzyme and 10X PCR Buffer Il manufactured by Life
Technologies as compared to the original Profiler Plus® and Profiler Plus® ID Kits
containing AmpliTaq Gold® enzyme and 10X PCR Buffer Il manufactured by Roche
Molecular Systems.
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Conclusions
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Table 8 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the AmpF(STR®
Control DNA 9947A and
the DNA test samples at
all loci

Incorrect volume or absence of
AmpF(STR® PCR Reaction Mix,
Profiler Plus® Kit or Profiler Plus® /D
Kit Primer Set, or AmpliTaq Gold®
DNA Polymerase

Repeat amplification.

No activation of AmpliTaq Gold® DNA
Polymerase

Repeat amplification, making sure to hold
reactions initially at 95°C for 11 minutes.

Master Mix not vortexed thoroughly
before aliquoting

Vortex the Master Mix thoroughly.

Profiler Plus® Kit or Profiler Plus® /D
Kit Primer Set exposed to too much
light

Store the Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Use of incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling
parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into contact with block
after first cycle. Repeat test.

Wrong PCR reaction tube

Use Applied Biosystems MicroAmp® Reaction
Tubes with Caps or a MicroAmp® optical 94-well
plate.

MicroAmp® Base used with tray/
retainer set and tubes in GeneAmp®
9700

Remove MicroAmp® Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in Chapter 3,
“Electrophoresis” on page 25.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Appendix A Troubleshooting

Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR® Control
DNA 9947A but partial or
no signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantitate DNA and add 1.0-2.5 ng of DNA.
Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ Kit.

Dilution of test sample DNA in water
or wrong buffer (for example, TE
formula with incorrect EDTA
concentration)

Redilute DNA using low-TE Buffer (with 0.1 mM
EDTA.

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

See “Stutter products” on page 73.

Some but not all loci
visible on
electropherogram of
DNA test samples

Test-sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ Kit.

Test sample contains high
concentrations of a PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Poor peak height

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler

balance parameters.
GeneAmp® PCR System 9700 with Use Applied Biosystems GeneAmp® PCR System
Aluminum 96-Well block or third- 9700 with silver or gold-plated silver blocks only,
party thermal cyclers or the Veriti® 96-Well Thermal Cycler.
110 AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide



PCR Work Areas

Work area setup and labdesign............ ... i 111
PCRsetupworkarea......... ...t 111
Amplified DNA workarea . ..............uuuuiiiiiiiiinnnn 112

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are
using the AmpF(STR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the AmpF(STR® kits (and other PCR-based tests) enables
amplification of minute quantities of DNA, necessitating precautions to avoid
contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

¢ Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ DPipettors

AmpFISTR® Profiler Plus® and Profiler Plus® ID PCR Amplification Kits User Guide 111



E Appendix B PCR Work Areas
Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The Profiler Plus® and Profiler Plus® ID Kits are not validated for
use with the GeneAmp® PCR System 9700 with the Aluminium 96-Well Block.
Use of this thermal cycling platform may adversely affect performance of the kits.

e Veriti® 96-Well Thermal Cycler
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C Ordering Information

Equipment and materials not included

Table 9 and Table 10 list required and optional equipment and materials not supplied
with the Profiler Plus® Kit. Unless otherwise noted, many of the items are available
from major laboratory suppliers (MLS).

Table 9 Equipment

Equipment Source
Applied Biosystems 3100/3100-Avant Genetic Analyzer Contact your local Life
Applied Biosystems 3130/3130x{ Genetic Analyzer Ig;r:soézgziesales
Applied Biosystems 3500/3500xL Genetic Analyzer for Human Identification
Applied Biosystems 310 Genetic Analyzer
GeneAmp® PCR System 9700 with the Silver 96-Well Block ' N8050001
GeneAmp® PCR System 9700 with the gold-plated silver 96-well block 4314878
Veriti® 96-Well Thermal Cycler 4375786
Silver 96-well sample block N8050251
Gold-plated silver 96-well sample block ' 4314443
Tabletop centrifuge with 96-well plate adapters (optional MLS

Table 10 User-supplied materials
Itemt? Source

AmpF(STR® Profiler Plus® and Profiler Plus® /D PCR Amplification Kits 4303326
3100 Analyzer materials
96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well ' 4316471
GeneScan™ 500 ROX™ Size Standard 401734
Running Buffer, 10X 402824
Hi-Di™ Formamide 4311320
DS-32 Matrix Standard Kit (Dye Set F) . 4345831
MicroAmp® Optical 96-well reaction plate N8010560
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Equipment and materials not included

Itemt? Source
250-pL glass syringe (array-fill syringe) 4304470
5.0-mL glass syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100/3100-Avant instrument, refer to Appendix B of the 3700 Genetic
Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Pub. no. 4335393).

3130x! Analyzer materials

96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3130/3130x( Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 ROX™ Size Standard 401734
Running Buffer, 10X 402824
DS-32 Matrix Standard Kit (Dye Set F) 4345831
MicroAmp® Optical 96-well reaction plate N8010560
Hi-Di™ Formamide 4311320

For a complete list of parts and accessories for the 3130/3130x! instrument, refer to Appendix A of the Applied Biosystems
3130/3130x( Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub. no. 4352716).

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4® polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4® polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
GeneScan™ 500 ROX™ Size Standard 401734
DS-33 Matrix Standard Kit (Dye Set G5) 4345833

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems 3500/3500xL
Genetic Analyzer User Guide (Pub. no. 4401661)

310 Analyzer materials

310 DNA Analyzer capillary array, 47-cm 402839
0.5 mL sample tray 5572
96-well tray adaptor (for 9700 thermal cycler trays) 4305051
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Equipment and materials not included

Itemt? Source
GeneScan™ 500 ROX™ Size Standard 401734
Running Buffer, 10X 4335643
Genetic analyzer septa retainer clips for 96-tube sample tray 402866
Genetic analysis sample tubes (0.5-mL) 401957
Septa for 0.5-mL sample tubes 401956
DS-32 Matrix Standard Kit (Dye Set F) for the 310 Genetic Analyzer 4312131
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 96-well base (holds 0.2-mL reaction tubes) N8010531
MicroAmp® 96-well full plate cover N8010550
MicroAmp® 96-well tray/retainer set 403081
POP-4® polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the 310 Genetic Analyzer User

Guide (Pub. no. 4317588).

PCR Amplification

MicroAmp® 96-well tray N8010541
MicroAmp® reaction tube with cap, 0.2-mL N8010540
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 8-cap strip N8010535
MicroAmp® 96-well tray/retainer set 403081
MicroAmp® 96-well base N8010531
MicroAmp® clear adhesive film 4306311
MicroAmp® optical adhesive film 4311971
MicroAmp® optical 96-well reaction plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 05 M MLS
Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any
chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Specific chemical CAS Chemical Phrase
handling
26628-22-8 | Sodium Azide Sodium azide may react with lead and copper
plumbing to form highly explosive metal azides.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

@ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:
In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29cfr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

* Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Obtain SDSs

Obtain support

Portable document format (PDF) versions of this guide and the documents listed
above are available at www.lifetechnologies.com.

Note: To open the user documentation available from the Applied Biosystems web
site, use the Adobe® Acrobat® Reader® software available from www.adobe.com.

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.

For HID support:
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¢ Obtain information about customer training

* Download software updates and patches

Limited Product Warranty
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Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life

Technologies’ website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/support.
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